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Предисловие  
COSMOS/FFE® (FFE � сокращение от Fast Finite Element (Быстрый КЭ-расчет)) это 
новый класс программ конструирования и КЭ-расчета, разрабатываемый и распро-
страняемый Structural Research and Analysis Corporation. Основу программы состав-
ляют быстрые итерационные алгоритмы решений и технология базы данных, 
адаптированная для КЭ-расчета и автоматизированного проектирования. Новые тех-
нологии FFE, разработанные с нуля, позволят вам быстро получать точные и надеж-
ные решения сложных задач, для решения которых обычно требуются 
суперкомпьютеры с большими объемами дисковой и оперативной памяти, на персо-
нальных компьютерах и рабочих станциях. 

Термальный модуль COSMOS/FFE способен рассчитывать линейные и нелинейные 
задачи теплопереноса устойчивого и переходного состояний. Статический модуль 
COSMOS/FFE способен рассчитывать конструкции с различными граничными усло-
виями и подвергающиеся действию различных статических нагрузок. Модули ис-
пользуют обширную библиотеку одно-, двух- и трехмерных элементов. Свойства 
материала могут быть изотропными, ортотропными и зависящими от температуры. В 
качестве термальных граничных условий используются: теплоперенос через излуче-
ние и конвекцию, предписанные узловые температуры и тепловой поток с возможно-
стью зависимости от времени или температуры.  Нагрузками в термальном расчете 
выступают тепловой поток, температура или тепловыделение, зависящее от времени. 
В линейном статическом расчете используются следующие нагрузки: сосредоточен-
ные силы, распределенная нагрузка, гравитационная и термальная нагрузки. Резуль-
таты термального расчета выводятся как узловые температуры и градиенты 
температур, статического расчета � напряжения, деформации и силы реакции. В гра-
фическом постпроцессинге используются контурные графики, XY-графики, графики 
сечений и графики изотерм. 

В термальном модуле COSMOS/FFE нет ограничений на размер задачи. Однако огра-
ничения модуля пре- и постпроцессинга, GEOSTAR, требуют, чтобы число узлов или 
элементов не превышало 64,000 или 250,000 на системах Unix. 

О данном руководстве � 
Данное руководство предназначено для помощи в проведении термального расчета в 
термальном модуле COSMOS/FFE Версии 1.75. В первой главе приведено краткое 
описание теоретических основ термального расчета, включая определяющие диффе-
ренциальные уравнения. Во второй главе описаны расчетные возможности термаль-
ного модуля FFE.  Глава 3 описывает элементы, доступные для использования в 
расчете. Команды, необходимые для выполнения расчета теплопереноса, приведены 
в Главе 4. В Главе 5 представлено подробное описание примеров, а в Главе 6 приве-
дены проверочные задачи 6. В приложении A приведены рекомендации по устране-
нию неполадок. 
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Другие руководства� 
При работе с термальным модулем COSMOS/FFE вам могут понадобиться еще два ру-
ководства: 

Руководство пользователя COSMOS/M (Том 1) 

Руководство пользователя COSMOS/M (Том 1) предназначено для того, чтобы помочь 
пользователям установить программу, ознакомиться и также помочь им в понимании 
большинства свойств и концепций COSMOS/M. Руководство пользователя начинает-
ся с обзора структуры программы и ее возможностей; продолжается детальным опи-
санием примера для быстрого и уверенного начала работы с программой. Далее в 
руководстве дается обзор возможностей GEOSTAR, от построения геометрии моде-
ли, до создания сети, приложения нагрузок и граничных условий, выполнения расче-
та, проверки и постпроцессинга результатов, взаимодействия с CAD-системами и 
другими КЭ-программами, использования средств программирования командного 
языка COSMOS/M, и многих других возможностей. Отдельная глава посвящена де-
тальному рассмотрению обширной библиотеки элементов COSMOS/M для конст-
рукционных, термических, жидкостных и электромагнитных задач. Также даются 
примеры моделирования и выполнения расчета. Для удобства пользователей, руко-
водство также представляет информацию о единицах измерения величин, вводимых 
в COSMOS/M, файлах баз данных, краткое описание команд, советы по устранению 
неполадок, а также сведения об улучшениях, появившихся в COSMOS/M версии 
1.75. 

Справочник команд COSMOS/M (Том 2) 

В этом Справочнике приведено подробное описание команд, их функций, синтаксиса 
и аргументов. Там, где это необходимо, приведены примечания, примеры и иллюст-
рации.  

Другие программы  

Кроме семейства модулей COSMOS/M и COSMOS/FFE, Structural Research предлагает 
полностью интегрированные расчетные системы для MicroStation Modeler, AutoCAD, 
Pro/ENGINEER и других CAD-программ. 

COSMOS/M DESIGNER II � расчетная система с возможностью трехмерного модели-
рования. Доступны несколько конфигураций системы. 

COSMOS/M DESIGNER � инструмент для автоматизированного механического про-
ектирования и расчета в среде AutoCAD.  Данная программа позволяет выполнять 
статический, частотный, термальный расчеты и расчет устойчивости конструкций, 
созданных в AutoCAD, не покидая среды AutoCAD.  

COSMOS/M CAD Interface � связующее звено между КЭ-расчетной программой и 
Pro/ENGINEER.  Находясь в среде Pro/ENGINEER, вы можете просто использовать 
меню COSMOS/M, чтобы получить доступ к двух- и трехмерным статическим, час-
тотным, термальным расчетам и расчетам устойчивости. 
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Условные обозначения  
Все имена команд (сокращенные и полные, включая путь) в тексте приводятся шриф-
том Arial, размером 10 пунктов, полужирным начертанием (например, A_STATIC 
(Analysis > STATIC > Static Analysis Options)). Приглашения программы приводятся 
шрифтом Times, размером 10 пунктов, а соответствующие данные выделены полу-
жирным начертанием: 
Control Panel: Propsets > Material Property 
Material property set >1 
Material Property Name >EX; Elasticity modulus 1st dir 
Property value >15.5E6 

Если после какого-либо приглашения не указано значение, то это означает, что вам 
необходимо нажать клавишу �Enter�. Более подробная информация по использова-
нию GEOSTAR приведена в Руководстве пользователя COSMOS/M. 

Описание команды и ее аргументов обычно приводится в следующем формате: 

PTMERGE 

(Control Panel:   Geometry > POINTS > Merge) 

Команда PTMERGE выполняет «слияние» КЛЮЧЕВЫХ ТОЧЕК. Две КЛЮЧЕВЫЕ 
ТОЧКИ будут «слиты», если соответствующие разности между их X, Y и Z-
координатами будут меньше либо равны указанного допуска. Можно выполнять 
«слияние» КЛЮЧЕВЫХ ТОЧЕК по всему диапазону или по указанному шаблону.  

Описание приглашений: 
Beginning keypoint Первая ТОЧКА шаблона (по умолчанию 1). 
Ending keypoint  Последняя ТОЧКА шаблона (по умолчанию максимальная метка ТОЧКИ в 

базе данных)  
Increment Инкремент КЛЮЧЕВЫХ ТОЧЕК в шаблоне (по умолчанию 1)  
Merge flag Признак «слияния».  

= All � выполнять «слияние» по всем ТОЧКАМ в модели  
= Among � выполнять «слияние» только по ТОЧКАМ в указанном шаблоне  
(по умолчанию � all) 

Данные, выводимые в GEOSTAR, а также примеры из файлы вывода в основном при-
водятся  шрифтом Courier размером 10 пунктов в рамке, как показано ниже (для ко-
манды MPLIST (Edit > LIST > Material Props)): 
Label Name Temp/BH_Cr Value  
A 1 EX 1 3.000000e+07  
... ...  
A 1 KX 0 5.370000e-03 

ПРИМЕЧАНИЕ: Описание, приводимое в таком формате, используется для обозна-
чения предупреждений, исключений и другой важной информации. Это не означает, 
что информацию в других форматах менее важна, просто в данном формате приво-
дятся в основном исключения, а не правила. 
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Линейный статический расчет  
Глава 1. 
Введение 

Введение 

Статический модуль COSMOS/FFE � быстрая и точная КЭ-расчетная программа для 
расчета линейных статических конструкционных задач. Программа использует но-
вую технологию решения больших систем совместных уравнений, разработанную в 
Structural Research, использующую технологию разреженных матриц и итерационные 
методы совместно с оригинальной методикой управления базой данных, что значи-
тельно уменьшает время расчета и требования к оперативной и дисковой памяти. 

Статический модуль COSMOS/FFE был написан с нуля с использованием наилучших 
методик КЭ-расчета с учетом двух целей: 1) удовлетворить основные потребности в 
моделировании и 2) использовать наиболее эффективные алгоритмы расчета без 
ущерба точности. Программа, в частности, подходит для расчета больших стандарт-
ных задач с разнообразными нагрузками и граничными условиями. 

Статический модуль COSMOS/FFE не является заменой модуля STAR, стандартного 
модуля линейного статического конструкционного расчета COSMOS/M. Возможно-
сти статического модуля FFE являются подмножеством возможностей модуля STAR. 
Модуль STAR может рассчитывать те же задачи, что и статический модуль FFE. 
Преимуществом статического модуля FFE является превосходство в скорости и ис-
пользовании вычислительных ресурсов в тех задачах, которые он поддерживает. Ес-
ли встречается обращение к неподдерживаемым возможностям, то программа 
выводит соответствующее сообщение. Эти сообщения и методы устранения непола-
док приведены в Приложении A. 

Теоретические основы  

Линейный статический расчет  

В статическом расчете вычисляются перемещения, деформации и напряжения, вы-
званные статическими нагрузками. Статической называется нагрузка, не вызываю-
щая инерционных эффектов или эффектов демпфирования, достаточно больших, 
чтобы их было необходимо учитывать при расчете. Статический расчет является ли-
нейным, если нелинейности, вызываемые пластичность, большими отклонениями, 
большими деформациями, плоскостными эффектами, контактом, эффектами ползу-
чести и релаксации могут быть либо линеаризованы, либо полностью проигнориро-
ваны. 

Динамические нагрузки, имеющие частоту, меньшую одной трети собственной часто-
ты конструкции могут быть аппроксимированы как линейный. Если вы сомневаетесь 
в том, являются ли нагрузки статическими или динамическими, рекомендуется вы-
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числить собственную частоту конструкции. 

Отношение напряжения-деформации в линейном расчете линейно, так же линейно и 
отношение между нагрузкой и отклонениями. Удваивание вектора нагрузки задачи 
вызовет удваивание всех связанных с ним результатов. Данное свойство линейного 
расчета используется при создании вторичных вариантов нагрузки, описание кото-
рых будет приведено ниже. 

Формулировка линейной статической задачи для решения методом перемещений пол-
ностью описывается следующим матричным уравнением: 

[K]{U}= {F}= {Fa}+ {Fc}   (1-1) 

где [K] � матрица жесткости конструкции, {U} � вектор неизвестных узловых пере-
мещений, {F} � вектор нагрузки. В вектор нагрузки {F} входят компоненты от меха-
нических, термальных и гравитационных нагрузок. Вектор нагрузки {F} можно 
выразить как комбинацию приложенных узловых сил {Fa} и сил реакций (или огра-
ничений в одной точке) {Fc}. В линейных статических задачах каждый из этих векто-
ров является суперпозицией механических, термальных и гравитационных нагрузок: 

{Fa}= {Fm}+ {Fth}+ {Fgr}  (1-2) 

Вектор механических нагрузок {Fm} вычисляется как сумма приложенных узловых 
сил и моментов и распределенной нагрузки на элементы: 

 

где {Fnd} � вектор приложенных узловых сил, а {Fe
pr} � вектор распределенной на-

грузки на элементы. Векторы термальной и гравитационной нагрузок вычисляются 
следующим образом: 

 

где {Fnt} � вектор узловых температур, {Fe
th} � вектор термальной нагрузки на элемен-

ты, [Me] � матрица массы элементов, а {a} � вектор ускорения. 

Множественные варианты нагрузки  

Множественные варианты нагрузки являются важной особенностью линейного расче-
та, которая поддерживается статическим модулем FFE  и модулем STAR. Данная 
возможность часто используется, поскольку она позволяет сэкономить время и пре-
доставляет удобный способ комбинирования нагрузок. Пользователь может задать до 
50 первичных вариантов нагрузки, и программа вычислит перемещения, деформации 
и напряжения за один проход. Для всех первичных вариантов нагрузки результаты 
будут доступны одновременно. После этого, используя результаты первичных вари-
антов нагрузки, можно задать вторичные варианты нагрузка. Более подробная ин-
формация о задании множественных вариантов нагрузки приведена в Главе 4. 
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Совместимые системы единиц измерения  

Во всех модулях COSMOS/M, включая статический модуль FFE, вы можете использо-
вать любую стандартную или нестандартную систему единиц, но при этом вы сами 
должны следить за совместимостью единиц и интерпретацией результатов. В табли-
це приведены стандартные совместимые системы единиц измерения физических ве-
личин, используемых в статическом модуле FFE. 

Таблица 1-1. Совместимые единицы измерения статического модуля COSMOS/FFE  

Описание Имя в COSMOS  *FPS1 (грави-
тационная) 

*SI2 (абсо-
лютная) 

*MKS3 (гра-
витационная) 

CGS4 (абсо-
лютная) 

Размеры 
Длина X, Y, Z  in  m  cm  cm 
Свойства материала 
Модуль упругости EX, EY, EZ  lbs/in2  Newton/m2 или 

Pascal  
kg/cm2  dyne/cm2 

Поперечный мо-
дуль 

GXY, GYZ, GXZ  lbs/in2  N/m2 или Pa  kg/cm2  dyne/cm2 

Отношение Пуас-
сона 

NUXY, NUYZ, 
NUXZ 

in/in (безраз-
мерная)  

m/m (безраз-
мерная)  

cm/cm (без-
размерная)  

cm/cm (без-
размерная) 

Плотность массы  DENS  lbs sec2/in4  kg/m3  kg sec2/cm4  g/cm3 
Коэффициент тер-
мического расши-
рения  

ALPX, ALPY, 
ALPZ  

in/(in °F)  m/(m °K)  cm/(cm °C)  cm/(cm °K) 

Нагрузки и Граничные условия  
Температура Temp  °F  °K  °C  °K 
Линейные пере-
мещения  

UX, UY, UZ  in  m  cm  cm 

Угловые переме-
щения  

RX, RY, RZ  radians  radians  radians  radians 

Силы (узловые)  FX, FY, FZ  lbs  Newton  kg  dyne 
Моменты (узло-
вые)  

MX, MY, MZ  in lbs  m N  cm kg  cm dyne 

Давление P  lbs/in2  N/m2 или Pa  kg/cm2  dyne/cm2 
Распределенная 
нагрузки на балку  

PB  lbs/in  N/m  kg/cm  dyne/cm 

Линейное ускоре-
ние  

ACEL  in/sec2  m/sec2  cm/sec2  cm/sec2 

Угловая скорость  OMEGA, 
CGOMEGA  

rad/sec  rad/sec  rad/sec  rad/sec 

Угловое ускорение  DOMEGA, 
DCGOMEGA 

rad/sec2 rad/sec2 rad/sec2 rad/sec2  

Результаты 
Перемещения  UX, UY, UZ, RES  in  m  cm  cm 
Напряжения  SX, SY, SZ, TXY, 

TYZ, TXZ, P1, P2, 
P3, VON, INT  

lbs/in2  N/m2 или Pa  kg/cm2  dyne/cm2 

Деформации  EPSX, EPSY, 
EPSZ, GMXY, 
GMYZ, GMXZ, 
ESTRN  

in/in (безраз-
мерная)  

m/m (безраз-
мерная)  

cm/cm (без-
размерная)  

cm/cm (без-
размерная) 

* Единицы совместимы с базой данных материалов COSMOS/M (PICK_MAT).  
1: FPS означает традиционную систему единиц США.  
2: SI означает Международную систему единиц.  
3: MKS означает Метрическую систему единиц.  
4: CGS означает французскую систему единиц. 
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Глава 2. 
Краткий обзор 

Введение 

В текущей версии статический модуль COSMOS/FFE может рассчитывать основные 
классы инженерных задач, встречающиеся в инженерной практике. Программа по-
стоянно дополняется новыми возможностями. В данной главе приведены возможно-
сти текущей версии модуля. 

Библиотека элементов  
! Двух- и трехмерные элементы стержня (TRUSS2D и TRUSS3D) 
! Трехмерные элементы балки (BEAM3D) 
! Треугольные элементы первого порядка с режимами плоских напряжений, пло-
ских деформаций и осесимметричным режимом (TRIANG) 

! Треугольные элементы первого порядка с режимами плоских напряжений, пло-
ских деформаций и осесимметричным режимом (TRIANG) 

! Четырехугольные элементы первого порядка с режимами плоских напряжений, 
плоских деформаций и осесимметричным режимом (PLANE2D) 

! Четырехугольные элементы второго порядка с режимами плоских напряжений, 
плоских деформаций и осесимметричным режимом (PLANE2D) 

! Треугольные (3-узловые) элементы оболочки первого порядка (SHELL3) 
! Четырехугольные (4-узловые) элементы оболочки первого порядка (SHELL4) 
! Шестигранные элементы первого и второго порядков (SOLID) 
! Призматические элементы первого и второго порядков (элементы SOLID, одна 
из граней которых вырождена в ребро) 

! Четырехгранные элементы первого порядка (TETRA4) 
! Четырехгранные элементы второго порядка (TETRA10) 

Подробное описание элементов приведено в Главе 3. 

Нагрузки  

Нагрузки можно прикладывать как непосредственно к узлам или элементам, так и к 
геометрическим примитивам. Можно задать до 50 первичных вариантов нагрузки. 

Можно прикладывать следующие нагрузки be: 

! Распределенная нагрузка на грани элементов в любой Декартовой координатной 
системе 

! Узловые сосредоточенные силы в любой координатной системе 
! Узловые сосредоточенные моменты для элементов оболочки 
! Распределенная нагрузка на ребра плоских элементов и элементов оболочки 
! Ускорение свободного падения для гравитационной нагрузки 
! Угловая скорость и/или ускорение для центробежной нагрузки 
! Термальная нагрузка: температуры, задаваемые пользователем 
! Термальная нагрузка: температуры, полученные в термальном расчете устойчи-
вого состояния 

! Термальная нагрузка: температуры, полученные в термальном расчете переход-
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ного состояния 
! Предписанные перемещения в любой координатной системе 

ПРИМЕЧАНИЕ: В руководствах COSMOS/M термальная, гравитационная и центро-
бежная нагрузки называются особыми нагрузками. Особые нагрузки рассматривают-
ся после других механических нагрузок, заданных для варианта нагрузки. В версии 
1.71 термальная нагрузка учитывалась только в варианте нагрузки 1, а в версии 1.75 
термальные нагрузки учитываются в любом варианте нагрузки. Перед выполнением 
расчета необходимо активизировать рассмотрение особых нагрузок в команде 
A_FFESTATIC (Analysis > STATIC > FFE Static Options). 

Ограничения по перемещениям  
! Ограничения по перемещениям в глобальной Декартовой координатной системе 
! Ограничения по перемещениям в глобальной сферической координатной систе-
ме 

! Ограничения по перемещениям в глобальной цилиндрической координатной 
системе 

! Ограничения по перемещениям в любой локальной координатной системе, за-
данной пользователем 

Свойства материала 

В данной версии поддерживаются только изотропные материалы. Если необходимо 
использовать ортотропные или изотропные материалы, используйте модуль STAR. 

Расчетные возможности  

Настройки расчета задаются в команде A_FEESTATIC (Analysis > STATIC > FFE Static 
Options). Доступны следующие варианты: 

1. Порядок элементов в расчете  
! Использование элементов первого порядка для элементов первого порядка в GEOSTAR 
! Использование элементов второго порядка для элементов первого порядка в GEOSTAR 
! Использование элементов первого порядка для элементов второго порядка в GEOSTAR 
! Использование элементов второго порядка для элементов второго порядка в GEOSTAR 

2. Особые нагрузки, которые будут учитываться при расчете  

! Термальная нагрузка  
! Гравитационная нагрузка  
! Центробежная нагрузка  

Результаты  

Результаты доступны для всех первичных вариантов нагрузки. 

! Листинги, графики и экстремальные значения перемещений 
! Листинги, графики и экстремальные значения напряжений 
! Листинги, графики и экстремальные значения деформаций 
! В файле вывода содержатся результаты-перемещения и некоторая информация о 
ресурсах, использованных при расчете 
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! Возможно задание вторичных вариантов нагрузки командой LCCOMB (Results > 
Combine Load Case)  

Глава 3. 
Библиотека элементов 

Введение 

В данной главе перечислены элементы, поддерживаемые текущей версии статического 
модуля COSMOS/FFE. Большинство двух- и трехмерных элементов запрограммиро-
ваны на иерархической основе первого и второго порядков. В GEOSTAR элементы 
могут быть созданы линейными или параболическими, но порядок элементов, ис-
пользуемый в расчете, управляется командой A_FFESTATIC (Analysis > STATIC > FFE 
Static Options), а не именем выбранной группы элементов. Например, в GEOSTAR вы 
можете создать элементы TETRA10, но указать использование элементов первого 
порядка в команде A_FFESTATIC. В этом случае данные средних узлов элементов на 
границах будут использоваться для геометрии. Аналогично, вы можете создать эле-
менты TETRA4, но указать использование элементов второго порядка в команде 
A_FFESTATIC. 

Плоские двухмерные непрерывные элементы 
! Треугольные (3-узловые) элементы первого порядка в режиме плоских напря-
жений (TRIANG) 

! Треугольные (6-узловые) элементы второго порядка в режиме плоских напря-
жений (TRIANG) 

! Треугольные (3-узловые) элементы первого порядка в режиме плоских дефор-
маций (TRIANG) 

! Треугольные (6-узловые) элементы второго порядка в режиме плоских дефор-
маций (TRIANG) 

! Треугольные (3-узловые) элементы первого порядка в осесимметричном режиме 
(TRIANG) 

! Треугольные (6-узловые) элементы второго порядка в осесимметричном режиме 
(TRIANG) 

! Четырехугольные (4-узловые) элементы первого порядка в режиме плоских на-
пряжений (PLANE2D) 

! Четырехугольные (8-узловые) элементы второго порядка в режиме плоских на-
пряжений (PLANE2D) 

! Четырехугольные (4-узловые) элементы первого порядка в режиме плоских де-
формаций (PLANE2D) 

! Четырехугольные (8-узловые) элементы второго порядка в режиме плоских де-
формаций (PLANE2D) 

! Четырехугольные (4-узловые) элементы первого порядка в осесимметричном 
режиме (PLANE2D) 

! Четырехугольные (8-узловые) элементы второго порядка в осесимметричном 
режиме (PLANE2D) 

Объемные трехмерные непрерывные элементы 
! Шестигранные (8-узловые) элементы первого порядка (SOLID) 
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! Шестигранные (20-узловые) элементы второго порядка (SOLID) 
! Пятигранные (8-узловые) элементы первого порядка (элементы SOLID с одной 
из граней, выродившейся в ребро) 

! Пятигранные (20-узловые) элементы второго порядка (элементы SOLID с одной 
из граней, выродившейся в ребро) 

! Четырехгранные элементы первого порядка (TETRA4) 
! Четырехгранные элементы второго порядка (TETRA10) 

Конструкционные элементы 
! Двух- и трехмерные элементы стержня (TRUSS2D и TRUSS3D) 
! Трехмерные элементы балки (BEAM3D) 
! Треугольные (3-узловые) элементы оболочки первого порядка (SHELL3) 
! Четырехугольные (4-узловые) элементы оболочки первого порядка (SHELL4) 

Вышеперечисленные элементы задаются командой EGROUP (Propsets > Element 
Group), приведенной в таблице 3-1. Также в этой таблице приведены команды управ-
ления свойствами элементов. Команды можно выполнить, использовав пути меню, 
приведенные в скобках. 

Таблица 3-1. Команды задания, изменения и вывода групп элементов 

Команда Функция Комментарии 
EGROUP  
(Propsets > Element Group)  

Задает группу элементов и связанные с 
ней опции.  

Максимально допустимое число 
групп элементов в модели � 20. 

EPROPSET  
(Propsets > New Property Set)  

Присваивает существующие группу 
элементов, наборы свойств материала и 
вещественных констант и координат-
ные системы элементы создаваемым 
элементам. 

 

EPROPCHANGE  
(Propsets > Change El-Prop)  

Изменяет связи между группами эле-
ментов, наборами свойств материала и 
вещественных констант. 

 

EGLIST  
(Edit > LIST > Element Groups) 

Выводит указанные группы элементов 
и связанные с ними опции.  

Вся информация, выводимая на 
экран, может быть перенаправ-
лена в текстовый файл с помо-
щью команды LISTLOG (Control 
> MISCELLANEOUS > List Log). 

EGDEL  
(Edit > DELETE > Element 
Groups)  

Удаляет указанные группы элементов и 
связанные с ними опции. 

 

Каждый элемент имеет различные опции расчета и моделирование (не больше вось-
ми), обозначенные OP1,�, OP8. Когда вы выполняете команду EGROUP, значения оп-
ций указываются в приглашениях, которые предоставляют их физическую 
интерпретацию для выбранного элемента. 

ПРИМЕЧАНИЕ: Вы можете выполнять расчет, использую элементы первого или 
второго порядков, независимо от того, какие элементы были созданы в действитель-
ности. 

На рис. 3-1 приведены графические представления всех элементов, поддерживаемых 
статическим модулем COSMOS/FFE. Подробное описание всех элементов приведено 
в Главе 4 Руководства пользователя COSMOS/M (Том 1). 

Для задания размеров поперечного сечения элементов (например, толщина элемента 
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SHELL3) используется команда RCONST (Propsets > Real Constant). Свойства мате-
риала задаются командами MPROP, PICK_MAT или R_MATLIB (если вам доступна биб-
лиотека материалов Infodex Mil 5), которые находятся в меню Propsets. 

 
Рис. 3-1. Поддерживаемые элементы  

Верхние и нижние грани элементов оболочки 

В GEOSTAR отображается только средняя поверхность элементов оболочки. Каждый 
элемент оболочки имеет верхнюю и нижнюю грани, положение которых определяет-
ся порядком задания узлов при создании элемента. Для просмотра порядка задания 
узлов используется команда ELIST (Edit > LIST > Elements). При использовании пра-
вила правой руки направление большого пальца указывает на верхнюю грань. 

 
Рис. 3-2. Верхняя и нижняя грани элементов оболочки 

Верхняя грань элементов, созданных при генерации КЭ-сети для ПОВЕРХНОСТИ, 
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будет иметь то же направление, что и внешняя нормаль к ПОВЕРХНОСТИ, которая 
определяется по правилу правой руки. Для определения направления верхней грани 
элементов, созданных при генерации КЭ-сети для ОБЛАСТИ, используется направ-
ление внешнего КОНТУРА. Для отображения параметрических направлений ПО-
ВЕРХНОСТЕЙ используется команда ACTMARK (Control > ACTIVATE > Entity Mark). 
Функции команды ACTMARK дублируются в таблице STATUS1. 

ПРИМЕЧАНИЕ: Для элементов TRIANG, PLANE2D, SOLID, TETRA4 и TETRA10 
всегда используется полное интегрирование. Соответствующие опции группы эле-
ментов игнорируются. Результаты, полученные в статическом модуле FFE сравнимы 
с результатами, полученными в модуле STAR при использовании полного интегри-
рования. 

Глава 4. 
Исходные данные  

Введение  

Для успеха любого КЭ-расчета критично правильное моделирование и задание на-
строек расчета. Независимо от типа расчета для численного решения необходима 
полная информация о рассматриваемой модели. КЭ-модель, передаваемая на расчет, 
должна содержать все данные, необходимые для каждого шага численного решения � 
геометрию, элементы, нагрузки, граничные условия, решения системы уравнений, 
визуализации и вывода результатов и так далее. В данной главе иллюстрируется про-
цедура создания модели для расчета в статическом модуле COSMOS/FFE. 

Полное описание процедур пре- и постпроцессинга в GEOSTAR приведено в Руково-
дстве пользователя COSMOS/M (Том 1). Данная глава не повторяет эти описания, а 
представляет краткий обзор команд, относящихся к статическому модулю COS-
MOS/FFE.  

Полное описание всех команд приведено в Справке программы и в Справочнике ко-
манд COSMOS/M (Том 2). 

Цикл моделирования и расчета в статическом модуле COSMOS/FFE  

Процедура КЭ-расчета состоит из следующих основных шагов: 

1. Создание геометрии задачи. 

2. Задание соответствующей группы элементов. 

3. Задание свойств материала. 

4. Задание вещественных констант для элементов стержня, балки, оболочки и плоских 
элементов. 

5. Генерация КЭ-сети для некоторой части модели с использованием соответствую-
щих элементов. 
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6. Повтор шагов с 2 по 5, если необходимо. 

7. Выполнение «слияния» совпадающих узлов на общих границах различных геомет-
рических примитивов командой NMERGE (Meshing > NODES > Merge). 

8. Наложение ограничений на КЭ-модель. 

9. Задание нагрузок на модель. 

10. Использование команды "ACTSET, LC" (Control > ACTIVATE > Set Entity) и задание 
вариантов нагрузки, если используются множественные варианты нагрузки. 

11. Использование команды A_FFESTATIC (Analysis > STATIC > FFE Static Options) для 
задания настроек расчета. 

12. Выполнение КЭ-расчета командой R_STATIC (Analysis > STATIC > Run Static 
Analysis). 

13. Использование команд меню Results для постпроцессинга результатов. Результаты 
можно отображать в графическом и текстовом форматах. Для перенаправления лис-
тингов с экрана в текстовый файл используется команда LISTLOG (Control > MIS-
CELLANEOUS > List Log). 

ПРИМЕЧАНИЕ: Команда R_STATIC запускает либо модуль STAR, либо статический 
модуль FFE. Модуль, который будет запущен, определяется по следующим прави-
лам: 1) Если вы не выполняли ни команду A_STATIC, ни команду A_FFESTATIC, то 
команда R_STATIC запустит модуль STAR. 2) Если были выполнены обе команды, то 
модуль, который будет запущен, определяется командой, которая была выполнена 
последней. Если последней была выполнена команда A_STATIC, то будет выполнен 
модуль STAR, а если последней выполнялась команда A_FFESTATIC, то будет выпол-
нен статический модуль FFE. 3) Если была выполнена только одна из двух команд, 
то будет запущен модуль STAR, если выполнялась команда A_STATIC, и статический 
модуль FFE, если выполнялась команда A_FFESTATIC. 

Схематически эти шаги можно представить, как показано на рисунке. 

 
Рис. 4-1. Процедура КЭ-моделирования и расчета 

Препроцессингом называются операции, выполняемые вами до выполнения расчета. 
Сюда входит создание геометрии модели, генерация КЭ-сети, приложение нагрузок и 
граничных условий, а также задание другой необходимой информации. Под расчетом 
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в схеме понимается задание настроек расчета и выполнение собственно расчета. 
Постпроцессингом называются операции в графической среде, выполняемые с ре-
зультатами расчета для облегчения интерпретации результатов и их понимания. 

В таблице приведена сводка команд, используемых для задания групп элементов, 
свойств материала, нагрузок и граничных условий, настроек расчета и настроек вы-
вода результатов. 

Таблица 4-1. Команды, необходимые для выполнения КЭ-расчета в FFE  

Функция Путь меню Краткое имя команды 
Задание свойств Propsets 

 > Element Group  
 > Material Property  
 > Real Constant  
 > Pick Material Lib  
 > User Material Lib  
 > Material Browser  
 > AISC Sect Table  
 > Change El-Prop  
 > New Property Set  
 > Beam Section 

. . . 
EGROUP  
MPROP  
RCONST  
PICK_MAT  
USER_MAT  
R_MATLIB  
PICK_SEC  
EPROPCHANGE  
EPROPSET  
BMSECDEF 

Задание нагрузок и 
граничных условий 

LoadsBC  
 > STRUCTURAL  
   > DISPLACEMENT  
   > FORCE  
   > PRESSURE  
   > GRAVITY  
  
 
> THERMAL  
   > TEMPERATURE  
  
> LOAD OPTIONS  
   > Read Temp as Load  
 

. . .  

. . . 
D_ команды задания предписанных перемещений *  
F_ команды задания узловых сил *  
P_ команды задания давления *  
Команды задания гравитации и центробежных сил: 
ACEL, OMEGA, DOMEGA, CGOMEGA, 
DCGOMEGA, CGLOC, GRVLIST 
. . .  
NT_ команды задания узловых температур * (тер-
мальная нагрузка) 
 . . .  
TEMPREAD команда считывания температур, по-
лученных в термальном расчете  

Проверка модели Meshing  
   > ELEMENTS  
     > Check Element  
Analysis  
   > Data Check  
   > Run Check   

. . . 

. . . 
E_CHECK  
. . .  
DATA_CHECK  
R_CHECK  

Задание настроек рас-
чета  

Analysis  
 > STATIC  
   > FFE Static Options  

. . .  

. . .  
A_FFESTATIC 

Выполнение статиче-
ского расчета 

Analysis  
 > STATIC  
   > Run Static Analysis  

. . .  

. . .  
R_STATIC 

Постпроцессинг Results  
   > Combine Load Case  
 > PLOT  
   > Deformed Shape 
   > Stress  
   > Strain  
   > Displacement  
   > Shear Diagram  
   > LIST  
   > Displacement  
   > Stress Component  
   > Strain Component  
   > Shear/Moment Value  
   > Beam End Force  
 > EXTREMES  

. . .  
LCCOMB  
. . .  
DEFPLOT  
ACTSTRS + STRPLOT  
ACTSTN + STNPLOT  
ACTDIS + DISPLOT  
SMPLOT  
. . .  
DISLIST  
STRLIST  
STNLIST  
SMLIST  
BEAMRESLIST  
. . .  
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   > Min/Max Displacement  
   > Min/Max Stress  
   > Min/Max Strain  
   > Shear/Moment  
   > Beam End Force 

DISMAX  
STRMAX  
STNMAX  
SMMAX  
BEAMRESMAX 

* Более подробная информация об этих командах приведена в Справочнике команд 

Особые нагрузки 

В руководствах COSMOS/M термальные, гравитационные и центробежные нагрузки 
называются особыми. Перед выполнением расчета необходимо активизировать рас-
смотрение особых нагрузок в команде A_FFESTATIC (Analysis > STATIC > FFE Static 
Options). Гравитационные и центробежные нагрузки можно задать для всех вариан-
тов нагрузки. 

При использовании гравитационной нагрузки необходимо задать значение ускорения 
свободного падения для каждого варианта нагрузки (пока вариант нагрузки активен). 
Для вычисления гравитационных сил необходимо также задать плотности материа-
лов. 

При использовании центробежной нагрузки необходимо задать угловые скорости 
и/или ускорения для каждого варианта нагрузки (пока вариант нагрузки активен). 
Для вычисления центробежных сил необходимо также задать плотности материалов. 

Расчет термальных напряжений 

Расчет термальных напряжений можно выполнить, непосредственно задав узловые 
температуры или считав профиль температуры из ранее выполненного термального 
расчета. 

Расчет термальных напряжений с заданием температур 

Для непосредственного задания узловых температур используются команды NTND, 
NTPT, NTCR, NTSF, ... и т.д., находящиеся в меню LoadsBC > THERMAL. Перед вы-
полнением расчета необходимо активизировать учет термальной нагрузки в команде 
A_FFESTATIC (Analysis > STATIC > FFE Static Options). Также необходимо задать ко-
эффициенты термического расширения материалов, использованных в модели. В 
версии 1.71 программы COSMOS/M термальную нагрузка можно было использовать 
только в варианте нагрузки 1. В версии 1.75 возможно использование различных 
профилей температуры для различных вариантов нагрузки. 

Расчет термальных напряжений с использованием результатов термального расчета 

После выполнения термального расчета полученное распределение температуры мож-
но использовать для вычисления термальных напряжений в материале. Для вычисле-
ния термальных напряжений необходимо выполнить следующие шаги: 

! Выполните термальный расчет  
! Активизируйте учет термальной нагрузки в команде A_FFESTATIC (Analysis > 

STATIC > FFE Static Options)  
! Если вы выполняли термальный расчет переходного состояния, то используйте 
команду TEMPREAD (LoadsBC > LOAD OPTIONS > Read Temp as Load), чтобы 
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указать временной шаг, распределение температур на котором будет использо-
вано для вычисления термальных напряжений 

! Выполните статический расчет, выполнив команду R_STATIC (Analysis > 
STATIC > Run Static Analysis)  

! Изменение температуры вычисляется в каждом узле вычитанием начальной 
температуры, задаваемой командой TREF (LoadsBC > LOAD OPTIONS > Refer-
ence Temp), из распределения температуры, полученного в термальном расчете 

! Если в термальном расчете температуры использовались как граничные усло-
вия, то при расчете напряжений данные температуры игнорируются, при усло-
вии, что в базе данных существует файл "имя_задачи.HTO". Если такой файл 
отсутствует, то эти температуры используются как термальная нагрузка для вы-
числения термальных напряжений. В файле .HTO хранятся температуры, вы-
численные в термальном расчете. 

Настройки статического расчета 

Для задания настроек расчета используется команда A_FFESTATIC; расчет выполняется 
командой R_STATIC. Ниже приведены синтаксис и описание команд The 
A_FFESTATIC и R_STATIC. 

Команда A_FFESTATIC  

(Control Panel: Analysis > STATIC > FFE Static Options) 

Команда A_FFESTATIC задает настройки линейного статического расчета в статиче-
ском модуле FFE. Заметьте, что команда A_STATIC задает настройки линейного ста-
тического расчета в модуле STAR. Команда, выполненная последней (A_STATIC или 
A_FFESTATIC), определяет, какой модуль будет запускаться командой  R_STATIC. 

Описание приглашений  
element-order  Порядок элементов, который будет использован в расчете. Независимо от имени 

группы элементов в базе данных, вы можете указать использование элементов 
первого (линейных) или второго (параболических) порядка. Например, если при 
моделировании вы использовали элементы TETRA4, а в расчете используете эле-
менты второго порядка, то при расчете будут учитываться средние узлы на ребрах 
элементов. С другой стороны, вы можете использовать элементы TETRA10 при 
моделировании и элементы первого порядка в расчете. Элементы SOLID обраба-
тываются аналогично, за исключением того, что для элементов и первого и второ-
го порядков используется одно имя группы элементов.  
EQ. 0 использовать непрерывные элементы первого порядка  
EQ. 1 использовать непрерывные элементы второго порядка 
(по умолчанию 1) 

special-loading  Признак учета особой нагрузки. Можно использовать один символ или любую 
двух- или трехсимвольную комбинацию из C, G и T.  
EQ. N не учитывать особые нагрузки 
EQ. C учитывать центробежную нагрузку 
EQ. G учитывать гравитационную нагрузку. 
EQ. T учитывать термальную нагрузку 
(по умолчанию N). 

Команда R_STATIC  

(Control Panel: Analysis > STATIC > Run Static Analysis) 
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Команда R_STATIC выполняет линейный статический расчет. Команда запускает ста-
тический модуль FFE Static, если была выполнена команда A_FFESTATIC, а команда 
A_STATIC нет. Или команда запускает модуль STAR, если команда A_FFESTATIC не 
была выполнена, или была выполнена, но после нее выполнялась команда A_STATIC. 
После успешного завершения расчета команда автоматически вычисляет напряжения 
и деформации в дополнение к перемещениям, если только не запускался модуль 
STAR с отключенным (в команде STRESS (Analysis > STATIC > Stress Analysis Op-
tions)) вычислением напряжений. В этом случае для вычисления напряжений можно 
воспользоваться командой R_STRESS (Analysis > STATIC > Run Stress Analysis). 

Примечания: 

1. Используются настройки, заданные в команде A_STATIC или A_FFESTATIC. 

2. Рекомендуемая процедура выполнения расчета: 

a. Создайте модель. 

b. Отобразите, выведите параметры и изучите модель. 

c. Выполните команду R_CHECK (Analysis > Run Check) для проверки исходных дан-
ных. 

d. Выполните команду A_FFESTATIC (Analysis > STATIC > FFE Static Options) для за-
дания порядка элементов и активизирования особых нагрузок или команду A_STATIC 
(Analysis > STATIC > Static Analysis Options) для задания настроек модуля STAR. Для 
других расчетов используйте аналогичные команды. 

e. Выполните команду R_STATIC (Analysis > STATIC > Run Static Analysis) для вы-
полнения линейного статического расчета. Для других расчетов используйте эквива-
лентные команды. 

f. Если при расчете будет обнаружена ошибка, то будет выведено соответствующее 
сообщение. Сообщения статического модуля FFE, а также их разъяснение и методы 
устранения неполадок, приведены в Приложении A настоящего руководства. Сооб-
щение также записывается в файл вывода (расширение .OUT). 

3. Команда вычислит перемещения и напряжения для всех вариантов нагрузки. Для 
создания вторичных вариантов нагрузки используйте команду LCCOMB (Results > 
Combine Load Case). 

4. Если используется модуль STAR и адаптивный h-метод, то команда R_STATIC будет 
последовательно повторять расчет, как указано в команде ADAPTIVE (Analysis > 
STATIC > Adaptive Method). 

ПРИМЕЧАНИЕ: Статический модуль FFE всегда рассчитывает напряжения и игно-
рирует признак вычисления напряжений, задаваемый в команде STRESS. 

ПРИМЕЧАНИЕ: Все напряжения вычисляются по глобальным напряжениям. Ко-
манды STRLIST (Results > LIST > Stress Component) и ACTSTR (Results > PLOT > 
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Stress) запросят координатную систему для вывода и отображения напряжений на 
этапе постпроцессинга. 

ПРИМЕЧАНИЕ: Напряжения не записываются в файл вывода. Для этой цели ис-
пользуйте команды LISTLOG (Control > MISCELLANEOUS > List Log) и STRLIST. 

Постпроцессинг  

Статический модуль FFE создает файл вывода имя_задачи.OUT. Этот файл является 
ASCII-файлом, и вы можете просматривать и редактировать его, используя любые 
средства. Результаты из базы данных можно просмотреть в GEOSTAR в графическом 
и текстовом форматах. В таблице приведено краткое описание команд постпроцес-
синга, относящихся к статическому модулю FFE. 

Таблица 4-2. Команды постпроцессинга результатов статического модуля FFE  

Команда *  Описание 
DEFPLOT  
DISLIST  
DISMAX  
STRLIST  
STRMAX  
STNLIST  
STNMAX  
SMLIST  
SMMAX  
BEAMRESLIST  
BEAMRESMAX  
ACTDIS  
DISPLOT  
ACTSTN  
STNPLOT  
ACTSTR  
STRPLOT  
SMPLOT  
SETPLOT  
LCCOMB  
LISTLOG  

Строит график деформированной формы 
Выводит перемещения  
Ищет экстремальные значения перемещений  
Выводит напряжений  
Ищет экстремальные значения напряжений  
Выводит деформации  
Ищет экстремальные значения деформаций  
Выводит поперечные силы и моменты для балок  
Ищет экстремальные значения поперечных сил и моментов для балок  
Выводит силы в балках  
Ищет экстремальные значения сил в балках  
Активизирует компонент перемещений для отображения 
Строит график активизированного компонента перемещений  
Активизирует компонент деформаций для отображения 
Строит график активизированного компонента деформаций 
Активизирует компонент напряжений для отображения 
Строит график активизированного компонента напряжений 
Строит диаграммы поперечных сил и моментов для балок 
Устанавливает цвета, диапазоны и масштаб для всех графиков  
Создает вторичный вариант нагрузки 
Используется для перенаправления листингов с экрана в файл 

* Путь меню приведен в таблице 4-1  

Проверка исходных данных модели 

Одной из сложностей, с которыми вы можете столкнуться при расчете, является избе-
жание ошибок в исходных данных модели. Некоторые из ошибок можно обнару-
жить, отобразив модель в различных проекциях, выведя на экран информацию об 
элементах, узлах, группах элементов, свойствах материла и вещественных констан-
тах, нагрузках и ограничениях. В небольших задачах часто бывает легче выполнить 
эти проверки, чтобы убедиться, что все исходные данные введены правильно. Одна-
ко вы можете упустить некоторые труднообнаружимые ошибки. В таких ситуациях, а 
также для больших задач, лучше будет выполнять проверки модели автоматически. 

Команда R_CHECK (Analysis > Run Check) выполняет тщательные проверки достовер-
ности, совместимости и полноты исходных данных и, если обнаружены ошибки, вы-
водит соответствующее сообщение. Команда ECHECK (Meshing > ELEMENTS > 
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Check Element) выполняет быструю проверку элементов в модели и удаляет вырож-
денные элементы. 

Настоятельно рекомендуется до выполнения расчета выполнять проверку модели ко-
мандой R_CHECK и исправлять найденные ошибки. 

Заметьте, что команда R_CHECK является инструментом общей проверки модели. Мо-
гут существовать ошибки, не обнаруживаемые этой командой. В большинстве случа-
ев сообщения, выводимые либо на экран, либо в ASCII-файл имя_задачи.CHK, 
предоставят информацию о природе этих ошибок и способе их устранения. Кроме 
этого статический модуль FFE выведет сообщения о неполадках, встреченных при 
расчете. Описание сообщений об ошибках приведено в Приложении A. 

Глава 5. 
Примеры 

Введение 

В данной главе приведены примеры выполнения линейного статического расчета в 
статическом модуле FFE. Примеры, приведенные в данной главе, являются больши-
ми практическими задачами, которые демонстрируют экономию времени и вычисли-
тельных ресурсов при использовании статического модуля FFE по сравнению с 
обычными решателями. В Главе 6 приведены задачи меньшего размера, демонстри-
рующие возможности статического модуля FFE. 

Файлы исходных данных для примеров, приведенных в этой главе, и проверочных за-
дач, приведенных в Главе 6, находятся в поддиректории PROBS. Имена файлов: 
FFESX1.GEO, FFESX2.GEO и FFESX3.GEO для примеров 1, 2 и 3, соответственно. 

Чтобы запустить пример, выполните следующую процедуру: 

! Создайте новую рабочую директорию, 
! Скопируйте файл исходных данных в новую директорию, 
! Запустите GEOSTAR, 
! Создайте новую задачу, 
! Считайте файл исходных данных командой FILE (File > Load...), 
! Следуйте инструкциям, приведенным в следующих разделах. 

Пример 1 � Расчет крышки подшипника 

Информация о модели  

Единица длины: миллиметр (mm) 

Единица силы: Ньютон (N) 

Единица давления: N/mm2 

Тип элементов: Четырехгранные 
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Порядок элементов: Второй 

Число элементов: 2700 

Число угловых узлов: 853 

Число степеней свободы: 15,393 

Крышка подшипника, показанная на рисунке, подвергается действию нагрузок и гра-
ничных условий, показанных на рисунке. Поскольку задача симметрична, расчет вы-
полняется только для половины модели. Если вы моделируете только часть 
симметричной задачи, важно использовать соответствующие граничные условия в 
плоскостях симметрии. Очевидно, что в данной задаче плоскость симметрии YZ не 
должна двигаться по глобальному направлению X. GEOSTAR предоставляет удоб-
ные средства задания граничных условий симметрии (см. Справку для команды DND 
(LoadsBC > STRUCTURAL > DISPLACEMENT > Define Nodes)). Заметьте, что для 
четырехгранных элементов угловые степени свободы отсутствуют и программа ав-
томатически их зафиксирует. 

 
Рис. 5-1. Полная модель крышки подшипника 

С помощью команды FILE (File > Load...) считайте файл FFESX1.GEO, или вы можете 
вводить все команды вручную, чтобы создать модель по шагам. Если вы будете вво-
дить команды вручную, путь меню для команд, использованных в примере, вы може-
те узнать в Справочнике команд или в Справке программы. Альтернативный способ 
создания модели � «выдавливание» кольца по направлению Y и выдавливание грани 
стенки по направлению Z. 

Содержимое файла FFESX1.GEO 
TITLE, ENGINE BEARING CAP 
PLANE,Y,0,1, 
PT,1,75,0,0, 
PT,2,0,0,0, 
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CRPCIRCLE,1,1,2,6,360,4, 
CRPCIRCLE,5,1,2,12,360,6, 
PT,13,25,0,5, 
PT,14,25,0,-5, 
CREXTR,13,14,1,X,44, 
CRINTCC,11,5,5,1,2,0.00005, 
CRDEL,5,14,9, 
CRINTCC,12,10,10,1,2,0.00005, 
CRDEL,14,15,1, 
CRFILLET,14,13,11,2.696,1,0,1E-006, 
CRFILLET,15,10,12,2.696,1,0,1E-006, 
CRLINE,16,21,24, 
CT,1,0,5,1,4,0, 
CT,2,0,5,9,16,14,13,6,7,8,9,10,15,0, 
RG,1,2,2,1,0, 
SFEXTR,1,10,1,Y,70, 
SFEXTR,13,16,1,Y,70, 
RGGEN,1,1,1,1,0,0,70,0, 
PT,38,0,0,5, 
PLANE,Z,5,1, 
CRPCIRCLE,43,38,13,25,90,1, 
PT,40,62.4803,70,5, 
PT,41,0,85,5, 
PT,42,0,-52.62607,5, 
CRARCCPT,44,36,41,42, 
CRLINE,45,39,41, 
CRDEL,12,12,1, 
SCALE,0, 
SFDEL,13,13,1, 
SFEXTR,11,11,1,Z,-10, 
SFEXTR,43,45,1,Z,-10, 
CT,5,0,6,5,11,43,45,44,39,0, 
RG,3,1,5,0, 
RGGEN,1,3,3,1,0,0,0,-10, 
RGSF,1,16,1,6, 
UNSELINP,SF,1,16,1,1, 
PH,1,RG,1,6,0.0001,1, 
PART,1,1, 
RGDENS,2,18,16,3,0,0001,1, 
EGROUP,1,TETRA4,0,1,0,0,0,0,0, 
MPROP,1,EX,200000,NUXY,0.3, 
MA_PART,1,1,1,1,0,4, 
CSANGLE,3,1,0,0,0,0,0,0,0, 
DRG,18,UX,0,18,1,UZ 
ACTSET,CS,0, 
DRG,20,UX,0,20,1,UZ, 
PRG,6,5,6,1,5,1, 
PRG,2,50,2,1,50,4 
HIDDEN; 
EPLOT; 



 25

 
Рис. 5-2. КЭ-сеть крышки подшипника 

Выполнение расчета  

После того, как модель создана, можно задать настройки расчета и выполнить расчет: 
Control Panel: Analysis > STATIC > FFE Static Options (A_FFESTATIC) 
Element Order [Second] > 
Loading Flag [N] > 
Примите значения 

ПРИМЕЧАНИЕ: Рекомендуется всегда использовать элементы второго порядка для 
получения более точных результатов. 

Затем выполните расчет: 
Control Panel: Analysis > STATIC > Run Static Analysis (R_STATIC) 

После вывода сообщения "Writing Static Analysis File!" появится экран статического 
модуля FFE. В верхней части экрана отображается версия модуля и дата, в средней 
части � название модели и информация о размера, и в нижней части � текущий этап 
решения и индикатор прогресса текущего этапа. В правом нижнем углу будет ото-
бражаться время, прошедшее с начала расчета. Если используются множественные 
варианты нагрузки, то будет отображаться номер варианта, который рассчитывается 
в данный момент. После загрузки базы данных решения для каждого варианта на-
грузки будет проходить через следующие этапы: формирование матрицы жесткости, 
вычисление перемещений и вычисление деформаций и напряжений. По завершении 
расчета управление будет передано GEOSTAR, и вы можете приступать к постпро-
цессингу. 

Постпроцессинг 

Все команды постпроцессинга находятся в меню Results. Во многих случаях графики 
будут выглядеть лучше, если отключить отображение граней элементов командой 
BOUNDARY (Display > DISPLAY OPTION > Set Bound Plot). Также графики улучшает 
оценка граней модели. Оценку граней можно использовать, даже если геометриче-
ские примитивы в модели отсутствуют. Чтобы активировать оценку граней, исполь-
зуйте команду: 
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Control Panel: Display > DISPLAY OPTION > Eval Element Bound (EVAL_BOUND) 
Boundary face evaluation flag [No] > 
Boundary edge evaluation flag [No] > Yes 
Tolerance angle to ignore curvature [20] > 60 
Примите значения  

Для постпроцессинга создайте четыре окна командой WCREATE (Control Panel: New 
Win). Для активизирования окна, щелкните в нем левой кнопкой мыши. 

Анимация деформаций 

Активизируйте закрашивание элементов, выполнив команду SHADE (Display > DIS-
PLAY OPTION > Shaded Element Plot), использовав значения по умолчанию. 

Выполните анимацию деформаций в окне 1: 
Control Panel: Display > DISPLAY OPTION > Animate (ANIMATE) 
Load Case [1] > 1 
Animation type [twoway] > 
Delay number [0] > 
Примите значения 

ПРИМЕЧАНИЕ: Вы можете замедлить анимацию, использовав большее значение за-
держки (delay factor) и/или увеличив окно. Для ускорения анимации используйте 
значение задержки по умолчанию и окно меньшего размера.  

На рисунке показан один из кадров анимации. 

 
Рис. 5-3. Деформированная форма 

Контурные графики перемещений 

Контурные графики перемещений можно строить как на деформированной, так и на 
недеформированной геометрии. Активизируйте окно 2 и постройте график результи-
рующих перемещений: 
Control Panel: Results > PLOT > Displacement (DISPLOT) 
Load case number [1] > 
Component [Ures] > 
Coordinate system [0] > 
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Выберите контурный график 
Plot type > Color_filled contour 
Beginning element [1] > 
Ending Element [2700] > 
Increment [1] > 
Shape flag > Deformed shape 
Scale Factor [277.346] > 
Примите значения 

На рисунке показан полученный график. Повторно используйте команду ANIMATE, 
чтобы выполнить анимацию контурного графика перемещений на деформированной 
геометрии. Возможно вам понадобиться изменить размеры окна, чтобы увидеть цве-
товые обозначения значений. 

 
Рис. 5-4. Контурный график перемещений 

Деформации элементов 
Control Panel: Results > PLOT > Strain (STNPLOT) 
Load case number [1] > 1 
Component [ESTRN] > 
Layer number [1] > (используется только для составных материалов) 
Coordinate system [0] > 
Face flag > (не используется) 
Click on Contour icon 
Plot Type > Color_filled contour 
Beginning element [1] > 
Ending [2700] > 
Increment [1] > 
Shape flag > Undeformed shape 

Полученный график показан на рисунке. Заметьте, что деформации � величины, зави-
сящие от элементов, и следовательно каждый элемент будет окрашен одним цветом. 
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Рис. 5-5. График деформаций элементов  

Примечание: 

Эквивалентные деформации (ESTRN) рассчитываются по формуле: 

ESTRN = 2[(ε1 + ε2)/3]1/2 

где: 

ε1 = 0.5[(EPSX - εa)2 + (EPSY - εa)2 + (EPSZ - εa)2] 

ε2 = [(GMXY)2 + (GMXZ)2 + (GMYZ)2]/4 

εa = (EPSX + EPSY + EPSZ)/3 

где: 

EPSX :  Средние деформации элемента по направлению X. 
EPSY :  Средние деформации элемента по направлению Y. 
EPSZ :  Средние деформации элемента по направлению Z. 
GMXY :  Поперечная деформация элемента в плоскости XY (изменение 

угла между линиям, первоначально параллельными осям X и Y).  
GMYZ :  Поперечная деформация элемента в плоскости YZ (изменение 

угла между линиям, первоначально параллельными осям Y и Z).  
GMXZ :  Поперечная деформация элемента в плоскости ZX (изменение 

угла между линиям, первоначально параллельными осям Z и X).  
ESTRN :  Эквивалентные деформации. 

Узловые напряжения 

Активизируйте окно 4 и постройте график напряжений по фон Мизесу: 
Control Panel: Results > PLOT > Stress (STRPLOT) 
Load case number [1] > 1 
Component [VON] > 
Layer number [1] > 
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Coordinate system [0] > 
Stress flag > Nodal stress 
Face-flag > (не используется) 
Выберите контурный график 
Plot Type > 
Beginning Element [1] > 
Ending Element [2700] > 
Increment [1] > 
Shape flag 0=Undsef 1=Def [0] > 
Scale factor [277.346] 

Компонент напряжений по фон Мизесу вычисляется из компонентов напряжений по 
формуле: 

VON = {(1/2)[(SX - SY)2 + (SX - SZ)2 + (SY - SZ)2] + 3(TXY2 + TXZ2 + TYZ2)}1/2 

где: 

VON  напряжения по фон Мизесу 
SX  нормальные напряжения по направлению x 
SY  нормальные напряжения по направлению y 
SZ  нормальные напряжения по направлению z 
TXY  поперечные напряжения в плоскости xy 
TXZ поперечные напряжения в плоскости xz  
TYZ  поперечные напряжения в плоскости yz 

Компонент VON также можно выразить через главные напряжения P1, P2 и P3: 

VON = {(1/2)[(P1 - P2)2 + (P1 - P3)2 + (P2 - P3)2]}(1/2) 

Полученный график показан на рисунке. 

 
Рис. 5-6. График напряжений по фон Мизесу 

На рис. 5-7 показаны полученные графики в 4-оконной среде. Вы можете использовать 
команду METAFILE ((File > Printer SetUp > File) + (File > Print)), чтобы сохранить изо-
бражения в файлы, которые позже вы сможете просмотреть командой VIEW_META 
(File > FILE VIEW > View Metafile) или распечатать командой PLOT_META (File > 
Print). Также можно создать файлы форматов PostScript и HPGL (используя меню File 
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> Printer SetUp). Для установки параметров твердой копии используется команда PA-
PER_SETUP (File > Paper SetUp). 

 
Рис. 5-7. Графики в многооконной среде 

График результатов вдоль пути 

Вы можете проследить изменение отображенных на экране результатов вдоль произ-
вольного пути, определяемого узлами общим числом до 20. При этом будет автома-
тически построен график изменения. Горизонтальная ось представляет 
нормализованное расстояние от первого узла пути, вертикальная ось представляет 
значение величины. Постройте график изменения напряжений, отображенных в окне 
4: 
Control Panel: Results > PLOT > Path Graph (LSECPLOT) 
Pick/Input Node > 81 
Pick/Input Node > 262 
Pick/Input Node > 262 

Измените размер окна, чтобы получить лучшее изображение. 

ПРИМЕЧАНИЕ: Оценка границ зависит от окна. 
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Рис. 5-8. График изменения значений напряжений по фон Мизесу вдоль пути 

Используйте команду ANIMATE, чтобы выполнить анимацию графика напряжений по 
фон Мизесу на деформированной геометрии. 

Пример 2 � Расчет соединительного кронштейна  

Информация о модели  

Единица длины: Дюймы (in) 

Единица силы: Фунты (lb) 

Единица давления: Lbs/in2 

Тип элементов: Элементы оболочки  

Порядок элементов: Первый  

Число элементов: 3622 

Число угловых узлов: 1968 

Число степеней свободы: 11,808 

Необходимо вычислить напряжения в соединительном кронштейне, показанном на 
рисунке. 
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Рис. 5-9. Соединительный кронштейн 

Модель, показанная на рисунке, состоит из тонких пластин, которые удобнее всего 
моделировать элементами оболочки. В текущей версии статического модуля FFE 
поддерживаются треугольные (SHELL3) и квадратные (SHELL4) элементы оболочки. 
Элемент оболочки имеет 6 степеней свободы на узел. В данном примере демонстри-
руется использование множественных вариантов нагрузки. Следует заметить, что 
при использовании множественных вариантов нагрузки все граничные условия по 
перемещениям одинаковы для всех вариантов нагрузки. Четыре маленьких отверстия 
в нижней части кронштейна будут зафиксированы по всем степеням свободы, моде-
лирую жесткое болтовое соединение. 

Содержимое файла FFESX2.GEO  
C* 
C* Define element attributes 
C* 
EGROUP,1,SHELL3,0,0,0,0,0,0,0, 
RCONST,1,1,1,6,0.20,0,0,0,0,0, 
PICK_MAT,1,A_STEEL,FPS, 
C* 
C* Create geometry 
C* 
PT,1,0,0,0, 
CREXTR,1,1,1,Z,5, 
CREXTR,1,1,1,Y,5, 
CREXTR,3,3,1,Z,-5, 
SCALE,0, 
CRFILLET,4,2,1,.5,1,0,1E-006, 
CRFILLET,5,3,2,.5,1,0,1E-006, 
CRCOMPRESS,1,5, 
SFEXTR,1,5,1,X,5, 
SCALE,0, 
PT,17,2.5,0,2.75, 
PLANE,Y,0,1, 
CRPCIRC,17,17,7,1.25,360,6, 
PT,24,.75,0,1.25, 
CRPCIRCLE,23,24,7,.25,360,6, 
CSANGLE,3,0,2.5,0,2.75,0,0,0,0, 
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CRGEN,3,23,28,1,1,0,-90,0, 
CT,1,0,.25,3,6,8,1,0, 
CT,2,0,.25,1,22,0, 
CT,3,0,.125,1,26,0, 
CT,4,0,.125,1,32,0, 
CT,5,0,.125,1,36,0, 
CT,6,0,.125,1,42,0, 
RG,1,6,1,2,3,4,5,6,0, 
SCALE,0, 
ACTDMESH,RG,1, 
RGGEN,1,1,1,1,0,0,5,-5.5, 
RGSF,2,4,2,.25, 
RGSF,5,5,1,.25, 
CRLINE,79,15,13, 
CRLINE,80,14,11, 
CRLINE,81,10,2, 
CRLINE,82,4,6, 
CT,16,0,.25,4,47,16,9,79,0,1, 
CT,17,0,.25,4,80,6,15,9,0,1, 
CT,18,0,.25,4,3,5,2,82,0,1, 
CT,19,0,.25,4,81,1,4,2,0,1, 
RG,6,1,16,0, 
RG,7,1,17,0, 
RG,8,1,18,0, 
RG,9,1,19,0, 
C* 
C* Mesh and merge coincident nodes 
C* 
MA_RG,1,9,1,0,0, 
NMERGE,1,2208,1,0.0001,0,0,0, 
C* 
C* Activate shade plotting and plot elements 
C* to check orientation of adjacent elements 
C* 
SHADE,1; 
EPLOT; 
C* 
C* Reorient elements on regions 1, 2, 3, and 7 
C* 
RGREORNT,1,3,1, 
RGREORNT,7,7,1, 
C* 
C* Fix region 1 
C* 
DRG,1,ALL,0,1,1, 

Элементы оболочки имеют верхнюю и нижнюю грани, положение которых определя-
ется порядком задания узлов при создании элемента. Верхняя грань определяется на-
правлением большого пальца при использовании правила правой руки. Соседние 
элементы оболочки, не находящиеся в ортогональных плоскостях, должны быть со-
ответственно ориентированы, чтобы усреднение напряжений во время постпроцес-
синга давало результаты, имеющие смысл. Если соседние элементы ориентированы 
неправильно, значения напряжений на верхней грани элемента будут усредняться с 
напряжениями на нижней грани соседнего элемента, что приведет к неточным ре-
зультатам. Рекомендуется использовать отображение закрашенных элементов, по-
скольку верхняя грань закрашивается синим цветом, а нижняя � красным. Для 
изменения ориентации элементов на ОБЛАСТЯХ  1, 2, 3 и 7 использовались команды 
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ACTDMESH (Control > Default Meshing) и RGREORNT (Geometry > REGIONS > Re-
orient). Другим способом выхода из этой ситуации будет использование списков вы-
бора для отображения напряжений на выбранных элементах без усреднения (более 
подробная информация приведена в справке по команде AVERAGE (Results > Average 
Nodal Stress)). На рисунке показаны закрашенные элементы до и после изменения 
ориентации. 

 
Рис. 5-10. Грани элементов до и после изменения ориентации (ребра элементов не отображаются)  

Задание первого варианта нагрузки 

В файле FFESX2.GEO не содержатся команды для задания вариантов нагрузки. За-
метьте, что при задании первого варианта нагрузки его не нужно активизировать. 
Control Panel: LoadsBC > STRUCTURAL > PRESSURE > Define Regions (PRG) 
Beginning region > 2 
Pressure magnitude > 100 
Ending region [2] > 
Increment [1] > 
Unused option > 
Pressure Direction [Normal Direction] > 
Примите значения 

Задание второго варианта нагрузки 

Нагрузки связываются с тем вариантом нагрузки, который был активен при их зада-
нии. Активизируйте второй вариант нагрузки: 
Control Panel: Control > ACTIVATE > Set Entity (ACTSET) 
Set label > LC 
Выберите Continue  
Load Case set number [1] > 2 

Теперь вариант нагрузки 2 активен, и все задаваемые нагрузки будут связаны с ним. 
Следует заметить, что граничные условия по перемещениям одинаковы для всех ва-
риантов нагрузки. 
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Control Panel: LoadsBC > STRUCTURAL > PRESSURE > Define Curve (PCR) 
Beginning curve > 49 
Pressure magnitude > -500 
Ending curve [49] > 51 
Increment [1] > 
Pressure at the end of direction 1 [-500]> 
Pressure Direction [Normal Direction] > 
Примите значения 

Для вывода заданны групп элементов, свойств материала и вещественных констант 
используйте команды EGLIST, MPLIST и RCLIST, находящиеся в меню Edit > LIST. Для 
просмотра распределенных нагрузок, заданных для активного варианта нагрузки, ис-
пользуйте команду PLIST (LoadsBC > STRUCTURAL > PRESSURE > List). Также 
можно использовать команду R_CHECK (Analysis > Run Check). 

Выполнение расчета 

Теперь модель готова и можно задать настройки расчета и выполнить его. 
Control Panel: Analysis > STATIC > FFE Static Options (A_FFESTATIC) 
Element Order [Second] > First 
Loading Flag [N] > 

Заметьте, что в текущей версии для элементов оболочки поддерживается только пер-
вый порядок. Для особых нагрузок используется признак учета по умолчанию. 

Выполните расчет: 
Control Panel: Analysis > STATIC > Run Static Analysis (R_STATIC) 

Управление перейдет к статическому модулю FFE, который будет сообщать о про-
грессе расчета. По завершении расчета управление вернется к GEOSTAR и вы смо-
жете приступить к постпроцессингу. 

Постпроцессинг 

Все команды постпроцессинга находятся в меню Results. Вы можете выводить значе-
ния, строить графики и выполнять поиск экстремальных значений. Листинги, выво-
димые на экран, могут быть перенаправлены в файлы командой LISTLOG (Control > 
MISCELLANEOUS > List Log). 

Деформированная форма 

Отобразите график деформированной формы: 
Control Panel: Results > PLOT > Deformed Shape (DEFPLOT) 
Load Case [2] > 1 
Beginning element [1] > 
Ending element [3622] > 
Increment [1] > 
Scale factor [38.037] > 
Примите значения 

Полученный график показан на рисунке. Заметьте, что коэффициент масштаба, ис-
пользуемый по умолчанию, увеличивает отклонения до 10% размера модели. Ис-
пользуйте коэффициент, равный 1.0, чтобы отклонения отображались без искажений. 
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Рис. 5-11. График деформированной формы для варианта нагрузки 1 

 
Рис. 5-12. График деформированной формы для варианта нагрузки 2 

Контурные графики перемещений 

Контурные графики перемещений можно строить как на деформированной, так и на 
деформированной геометрии. 

Активизируйте оценку границ: 
Control Panel: Display > DISPLAY OPTION > Eval Element Bound (EVAL_BOUND) 
Boundary face evaluation flag [No]> 
Boundary edge evaluation flag [No]> Yes 
Выберите Continue  
Tolerance angle to ignore curvature [20]> 60 

Отобразите график результирующих перемещений: 
Control Panel: Results > PLOT > Displacement (DISPLOT) 
Load case number [1] > 
Component [Ures] > 
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Coordinate system [0] > 
Выберите контурный график 
Plot Type > Color_filled contour 
Beginning element [1] > 
Ending Element [3622] > 
Increment [1] > 
Shape flag > Deformed shape 
Scale Factor [38.037] > 
Примите значения 

Полученный график показан на рисунке. Используйте команду ANIMATE (Results > 
PLOT > Animate), чтобы выполнить анимацию контурного графика перемещений  на 
деформированной геометрии. 

 
Рис. 5-13. Контурный график перемещений для варианта нагрузки 1 

 
Рис. 5-14. Контурный график перемещений для варианта нагрузки 2 

Деформации элементов 

Деформации рассчитываются для каждого элемента. Отобразите график: 
Control Panel: Results > PLOT > Strain (STNPLOT) 
Load case number [2] > 1 
Component [ESTRN] > 
Layer number [1] > (используется только для составных материалов) 
Face-flag [Top] > 
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Coordinate system [0] > 
Выберите контурный график 
Plot Type > Color_filled contour 
Beginning element [1] > 
Ending element [3622] > 
Increment [1] > 
Shape flag > Undeformed shape 
Scale factor [38.037] > 
Примите значения 

Полученный график показан на рисунке. Поскольку значение деформации зависит от 
элемента, каждый элемент закрашен одним цветом. 

 
Рис. 5-15. График деформаций элементов для варианта нагрузки 1 

 
Рис. 5-16. График деформаций элементов для варианта нагрузки 2 

Графики напряжений 

Отобразите график напряжений по фон Мизесу: 
Control Panel: Results > PLOT > Stress (STRPLOT) 
Load case number [2] > 1 
Component [VON] > 
Stress flag > Nodal stress 
Layer number [1] > (используется только для составных материалов) 
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Face-flag [Top] > 
Coordinate system [0] > 
Выберите контурный график 
Plot Type > Color_filled contour 
Beginning element [1] > 
Ending element [3622] > 
Increment [1] > 
Shape flag > Deformed shape 
Scale factor [38.037] > 
Примите значения 

Полученный график показан на рисунке. 

 
Рис. 5-17. Контурный график напряжений по фон Мизесу для варианта нагрузки 1 

 
Рис. 5-18. Контурный график напряжений по фон Мизесу для варианта нагрузки 2 

График изменения результатов вдоль пути 

Вы можете проследить изменение отображенных на экране результатов вдоль произ-
вольного пути, определяемого узлами общим числом до 20. При этом будет автома-
тически построен график изменения. Горизонтальная ось представляет 
нормализованное расстояние от первого узла пути, вертикальная ось представляет 
значение величины. Постройте график изменения напряжений: 
Control Panel: Results > PLOT > Path Graph (LSECPLOT) 
Pick/Input Node > 409 
Pick/Input Node > 429 
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Pick/Input Node > 429 

ПРИМЕЧАНИЕ: Узлы, определяющие путь для команды LSECPLOT, выбираются, 
исходя из недеформированной геометрии. Поэтому для этой цели использовать кон-
турные графики на недеформированной геометрии. 

Полученный график показан на рисунке. 

 
Рис. 5-19. График изменения напряжений по фон Мизесу вдоль пути для варианта нагрузки 2 

 
Рис. 5-20. График изменения напряжений по фон Мизесу вдоль пути для варианта нагрузки 1 

Используйте команду ANIMATE (Results > PLOT > Animate), чтобы выполнить анима-
цию графика напряжений по фон Мизесу и соответствующего графика изменений 
напряжений вдоль пути одновременно. 

Вторичные варианты нагрузки 

После того, как получены результаты для всех первичных вариантов нагрузки, вы мо-
жете задавать вторичные варианты нагрузки. Создайте вариант нагрузки 51 суперпо-
зицией варианта нагрузки 1 с коэффициентом 1.5 и варианта нагрузки 2 с 
коэффициентом 3: 
Control Panel: Results > Combine Load Case (LCCOMB) 
New load case number > 51 
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Load case number for term 1 > 1 
Load case factor for term 1 [1] > 1.5 
Load case number for term 2 > 2 
Load case factor for term 1 [1] > 3 
Load case number for term 3 > 

Постпроцессинг результатов варианта нагрузки 51 выполняется так же, как и для пер-
вичных вариантов нагрузки. Ниже приведен график напряжений по фон Мизесу для 
варианта нагрузки 51. 

 
Рис. 5-21. График напряжений по фон Мизесу для варианта нагрузки 51 

Пример 3 � Модель винта 

Файл исходных данных для этой модели называется FFESX3.GEO. Загрузите этот 
файл в GEOSTAR и после создания модели выполните расчет и выполняйте пост-
процессинг аналогично предыдущим примерам. Ниже приведена информация, опи-
сывающая размер модели. 

Информация о модели 

Тип элементов: Четырехгранные 

Порядок элементов: Второй 

Число элементов: 21,430 

Число угловых узлов: 5,103 

Число степеней свободы: 104,175 

Ниже приведены некоторые результаты расчета. 
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Рис. 5-22. КЭ-сеть винта  

 
Рис. 5-23. Контурный график перемещений  

 
Рис. 5-24. Контурный график напряжений по фон Мизесу 

Глава 6. 
Проверочные задачи 

Введение 

В данной главе приведены проверочные задачи, иллюстрирующие использование эле-
ментов и возможностей статического модуля FFE.  

Файлы исходных данных проверочных задач находятся в поддиректории PROBS. 
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В таблице приведен список проверочных задач. 

Таблица 6-1. Список проверочных задач 

Имя задачи Элементы Порядок Название 
FFES1  PLANE2D  Первый Длинный толстостенный цилиндр 
FFES2A  SHELL3  Первый Прямоугольная плита, лежащая на опорах  
FFES2B  SHELL3  Первый Прямоугольная плита, лежащая на опорах  
FFES3  PLANE2D  Второй Расчет термальных напряжений двухмерной конструк-

ции 
FFES4  PLANE2D  Второй Отклонения консольной балки  
FFES5  SHELL3  Первый Перемещения круглой балки  
FFES6A  SOLID  Второй Изгиб балки  
FFES6B  SOLID  Второй Изгиб балки  
FFES7  SOLID  Второй Расчет термальных напряжений трехмерной конструк-

ции 
FFES8  PLANE2D  Второй Прямоугольная плита, подвергающаяся действию тре-

угольной термальной нагрузки 
FFES9  PLANE2D  Второй Полый толстостенный цилиндр 
FFES10  SHELL4  Первый Цилиндрическая оболочка кровли 
FFES11  SHELL4  Первый Кручение балки квадратного сечения 
FFES12  SOLID  Второй Сферическая крышка, подвергающаяся действию рас-

пределенной нагрузки 
FFES13  PLANE2D  Второй Вращающийся диск 
FFES14  SHELL4  Первый Реакции и отклонения консольной балки  
FFES15A  PLANE2D  Первый Отклонения криволинейной балки  
FFES15B  PLANE2D  Второй Отклонения криволинейной балки  
FFES15C  TRIANG  Второй Отклонения криволинейной балки  
FFES15D  TETRA10  Второй Отклонения криволинейной балки  
FFES15E  SOLID  Первый Отклонения криволинейной балки  
FFES15F  SOLID  Второй Отклонения криволинейной балки  
FFES16  TRIANG  Первый Расчет эллиптической мембраны  
FFES17  PLANE2D  Второй Расчет термальных напряжений плоской плиты  
FFES18  TRUSS3D  --  Ферма с шарнирными соединениями 
FFES19  TRUSS2D  --  Расчет термальных напряжений фермы  
FFES20  BEAM3D  --  Напряжения и отклонения балки  
FFES21A  BEAM3D  --  Зажатая балка с вынужденными перемещениями  
FFES21B  BEAM3D  --  Зажатая балка с вынужденными вращениями  
FFES22  TRUSS3D  --  Отклонения подвеса 
FFES23  TRUSS3D  --  Расчет статически неопределимых сил реакции 
FFES24A  TRUSS3D  --  Ферма с вертикальной нагрузкой 
FFES24B  TRUSS3D  --  Ферма с вертикальной нагрузкой 
FFES25  BEAM3D  --  Расчет термальных напряжений рамы 
FFES26  BEAM3D  --  Расчет термальных напряжений простой рамы 
FFES27 BEAM3D  --  Расчет рамы с комбинированными нагрузками 
FFES28  TRUSS2D  --  Ферма с сосредоточенной нагрузкой 

FFES1: Длинный толстостенный цилиндр 

Тип: 

Статический расчет, плоские элементы в осесимметричном режиме (PLANE2D). 

Литература: 

Timoshenko, S. P. and Goodier, J., "Theory of Elasticity," McGraw-Hill, New York, 1951, 
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pp. 58-60. 

Задача: 

Вычислить радиальные напряжения в бесконечно длинном толстостенном цилиндре, 
подвергающемся действию внутреннего давления p. 

Дано: 

a = 100 in 

b = 115 in. 

p = 1000 psi 

E = 30 x 106 psi 

ν = 0.3 

Советы по моделированию: 

КЭ-сеть модели содержит 3х3 элемента. 

Сравнение результатов: 
r (расстояние) (in.)  Радиальные напряжения σr (psi)  

Теория 
Радиальные напряжения σr (psi) 

COSMOS/M 
102.5 (элемент 1)  - 802.40 - 802.50 
107.5 (элемент 2)  - 447.75 - 447.80 
112.5 (элемент 3)  - 139.34 - 139.40 

 
Рис. FFES1-1 

FFES2A, FFES2B: Прямоугольная плита, лежащая на опорах  

Тип: 
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Статический расчет, треугольные элементы оболочки (SHELL3). 

Литература: 

Timoshenko, S. P. and Woinowsky-Krieger, "Theory of Plates and Shells," McGraw-Hill 
Book Co., 2nd edition. pp. 143-120, 1962. 

Задача: 

Вычислить отклонения и напряжения в центре плиты, лежащей на опорах и подвер-
гающейся действию (A) сосредоточенной силы F, (B) распределенной нагрузки P. 

Дано: 

E = 30,000,000 psi 

ν = 0.3 

h = 1 in. 

a = b = 40 in. 

F = 400 lb 

p = 1 psi 

Советы по моделированию: 

Поскольку геометрия и нагрузка обладают двойной симметрией, расчет выполняется 
для четверти модели. 

Сравнение результатов: 
Задача  X (in.) Y (in.) Wmax в узле 25 (in.) 

Теория 
Wmax в узле 25 (in.) 

COSMOS/M 
A  20 20 0.0270230 0.027123 
B  20 20 3.78327 x 10-3 3.7915 x 10-3 

 
Рис. FFES2-1 
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FFES3: Расчет термальных напряжений двухмерной конструкции 

Тип: 

Линейный расчет термальных напряжений, плоские элементы в режиме плоских де-
формаций (PLANE2D). 

Задача: 

Определить перемещения и напряжений в задаче, показанной на рисунке, вызванные 
равномерным повышением температуры. 

Дано: 

E = 30 x 106 psi 

α = 0.65 x 10-5 /°F 

ν = 0.25 

T = 100° F 

L = 1 in. 

Сравнение результатов: 

Перемещения в узлах 2, 4 и 6 
 Теория COSMOS/M 
Y-перемещения (in.)  0.001083 0.001083 
XX-напряжения (psi)  - 26000.0 - 26000.1 

 
Рис. FFES3-1 
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FFES4: Отклонения консольной балки 

Тип: 

Статический расчет, плоские элементы в режиме плоских напряжений (PLANE2D). 

Задача: 

Консольная балка подвергается действию сосредоточенной силы, приложенной в сво-
бодном конце. Определить отклонения свободного конца и равномерные поперечные 
напряжения. 

Дано: 

E = 30 x 106 psi 

L = 10 in. 

h = 1 in. 

A = 0.1 in2 

ν = 0 

P = 1 lb 

Сравнение результатов: 
 Максимальные 

отклонения (in.) 
Поперечные  

напряжения (psi) 
Теория  - 0.001333 - 10.0 
COSMOS/M PLANE2D  - 0.001341 - 10.0 
COSMOS/M SHELL6 - 0.00139 - 10.0 

 
Рис. FFES4-1 



 48

FFES5: Перемещения круглой балки  

Тип: 

Статический расчет, элементы оболочки (SHELL3). 

Литература: 

Warren C. Young, "Roark's Formulas for Stress and Strain," Sixth Edition, McGraw Hill 
Book Company, New York, 1989. 

Задача: 

Найти отклонения по направлениям X и Y круглой балки, зафиксированной в одном 
конце, если в свободном конце приложена нагрузка по направлению X. 

Дано: 

E = 30E6 psi 

ν = 0 

b = 4 in. 

h = 1 in. 

R = 10 in. 

F = 200 lb 

Сравнение результатов: 

В нагруженном конце. 
 X-перемещения (in.) Y-перемещения (in.) 
Теория 0.712E-2 0.99E-2 
COSMOS/M  0.718E-2 0.99E-2 

 
Рис. FFES5-1 
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FFES6A, FFES6B: Изгиб балки 

Тип: 

Статический расчет, элементы SOLID. 

Литература: 

Roark, R. J., "Formulas for Stress and Strain," 4th Edition, McGraw-Hill Book Co., New 
York, 1965, pp. 104-106. 

Задача: 

Балки длиной L и высотой h закреплена в одном конце и нагружена в другом: (A) по-
перечной силой F, и (B) моментом M. Найти отклонения в свободном конце. 

Дано: 

L = 10 in. 

h = 2 in. 

E = 30 x 106 psi 

ν = 0 

F = 300 lb 

M = 2000 in-lb 

Советы по моделированию: 

Используются два варианта нагрузки (FFES6A, FFES6B). 

1. Четыре силы величиной F/4 приложены в узлах 6, 12, 18 и 24 по направлению xz 
(FFES6A). 

и, 

2. Две пары величиной M/2 приложены в узлах 6, 12, 18 и 24 (FFES6B). 

Сравнение результатов: 

Перемещения по направлению Z (in.) (узлы 21-24): 
 FFES6A FFES6B 
Теория  0.00500 - 0.00500 
COSMOS/M  0.00507 - 0.00495 
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Рис. FFES6-1 

FFES7: Расчет термальных напряжений трехмерной конструкции 

Тип: 

Линейный расчет термальных напряжений, элементы SOLID. 

Задача: 

Найти перемещения в трехмерной конструкции, показанной на рисунке, вызванные 
равномерным повышением температуры. 

Дано: 

E = 3 x 107 psi 

α = 0.65 x 10-5/°F 

ν = 0.25 

T = 100° F 

L = 1 in. 

Сравнение результатов: 
 X-перемещения (узлы 5, 6, 7, 8) X-перемещения (узлы 9, 10, 11, 12) 
Теория  0.000650 0.001300 
COSMOS/M  0.000650 0.001300 



 51

 
Рис. FFES7-1 

FFES8: Прямоугольная плита, подвергающаяся действию треугольной термаль-
ной нагрузки 

Тип: 

Линейный расчет термальной нагрузки, плоские элементы в режиме плоских напря-
жений (PLANE2D). 

Литература: 

Johns, D. J., "Thermal Stress Analysis," Pergamon Press, Inc., 1965, pp. 40-47. 

Задача: 

Конечная прямоугольная плита подвергается действию распределения температуры 
только по одному направлению, как показано на рисунке. Найти нормальные напря-
жений в точке A. 

Дано: 

a = 15 in. 

b = 10 in. 

To = -100 °F 

t = 1 in. 

E = 30 x 106 psi 

αc= 0.65 x 10-5 in./in./°F 
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Советы по моделированию: 

Поскольку задача и нагрузки обладают двойной симметрией, расчет выполняется 
только для четверти модели. 

Сравнение результатов: 
 σxx/(EαTo) (узел 45) 
Теория, метод 1  0.42 
Теория, метод 2  0.40 
COSMOS/M  0.43 

 
Рис. FFES8-1 

FFES9: Полый толстостенный цилиндр 

Тип: 

Статический расчет, плоский элемент в осесимметричном режиме (PLANE2D). 

Литература: 

Timoshenko, S. P. and Goodier, "Theory of Elasticity," McGraw-Hill Book Co., New York, 
1961, pp. 448-449. 

Задача: 

Полый цилиндр подвергается действию двух независимых нагрузок. 

1. Внутреннее давление. 

2. Устойчивое осесимметричное распределение температуры, задаваемое уравнением: 

T(r) = (Ta/ln(b/a))ln(b/r) 

где Ta � температура внутренней поверхности, а T(r) � температура на радиусе r. 

Дано: 
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E = 30 x 106 psi 

a = 1 in. 

b = 2 in. 

ν = 0.3 

α = 1 x 10-6 1/deg 

Pa = 100 psi 

Ta = 100 deg 

Сравнение результатов: 

На радиусе r = 1.2875 in. (элементы 13, 15). 
 σr, psi σθ, psi 
Теория  - 398.34 - 592.47 
COSMOS/M  - 398.2 - 596.5 

 
Рис. FFES9-1 

FFES10: Цилиндрическая оболочка кровли 

Тип: 

Статический расчет, элементы оболочки (SHELL4). 

Литература: 

Pawsley, S. F., "The Analysis of Moderately Thick to Thin Shells by the Finite Element 
Method," Report No. USCEM 70-l2, Dept. of Civil Engineering, University of California, 
l970. 

Задача: 

Найти вертикальные отклонения в центре оболочки кровли, прогибающейся под соб-
ственным весом. Размеры и граничные условия показаны на рисунке. 

Дано: 
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r = 25 ft 

E = 3 x 106 psi 

ν = 0 

Вес оболочки = 90 lbs/sq ft 

Советы по моделированию: 

Поскольку задача симметрична, расчет выполняется для четверти модели. Вес оболоч-
ки смоделирован сосредоточенными силами, приложенными в узлах. 

Сравнение результатов: 

Вертикальные отклонения в середине свободного края (узел 25): 
 εx, (in.) 
Теория  0.3024 
COSMOS/M SHELL4  0.3036 

 
Рис. FFES10-1 

 
Рис. FFES10-2 
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FFES11: Кручение балки квадратного сечения 

Тип: 

Статический расчет, элементы оболочки (SHELL4). 

Литература: 

Timoshenko, S. P., and Goodier, J. N., "Theory of Elasticity," McGraw-Hill, New York, 
l95l, p. 299. 

Задача: 

Найти поперечные напряжения и угол поворота балки с полым квадратным попереч-
ным сечением, подвергающейся действию крутящего момента T. 

Дано: 

E = 7.5 psi 

ν = 0.3 

t = 3 in. 

a = 150 in. 

L = 1500 in. 

T = 300 lb in. 

Сравнение результатов: 
 Напряжения σ, lb/in. Вращение θ, rad 
Теория  0.00222 0.0154074 
COSMOS/M  0.00222 (ср.) 0.01503 

 
Рис. FFES11-1 
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FFES12: Сферическая крышка, подвергающаяся действию распределенной на-
грузки 

Тип: 

Статический расчет, элементы (SOLID). 

Литература: 

Reddy, N. J. "Exact Solutions of Moderately Thick Laminated Shells," J. Eng. Mech. Div. 
ASCE, Vol. 110, (1984), pp. 794-809. 

Задача: 

Вычислить отклонения в центре сферической крышки, лежащей на опорах и подвер-
гающейся действию распределенной нагрузки (q = 1.), приложенной нормально к по-
верхности крышки. Чтобы наложить граничные условия опор на объемные элементы, 
необходимо использовать 2 слоя элементов по толщине. Чтобы сохранить геометрию 
криволинейной поверхности, необходимо использовать как минимум 8 элементов на 
сторону. КЭ-сеть модели состоит из 8x8x2 элементов. 

Дано: 

Геометрия: 

R = 96 

Длина стороны a = b = c = d = 32 in. 

h = 0.32 in. 

Свойства материала: 

E = 1E7 psi 

ν = 0.3 

Советы по моделированию: 

Граничные условия: 

симметрии: 

1. Все узлы на плоскости A, Uy = 0 

2. Все узлы на плоскости B, Ux = 0 

опор: 

1. Все узлы на стороне c, радиальные перемещения = 0, перемещения на плоскости C = 
0 
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2. Все узлы на стороне d, радиальные перемещения = 0, перемещения на плоскости D 
= 0 

Сравнение результатов: 
 Wmax (in.) 
Теория  0.3139E-2 
COSMOS/M  0.32906-2 

 
Рис. FFES12-1 

FFES13: Вращающийся диск 

Тип: 

Статический расчет, плоские элементы в осесимметричном режиме (PLANE2D), цен-
тробежная нагрузка. 

Литература: 

S. P. Timoshenko and J. N. Goodier, "Theory of Elasticity," McGraw-Hill, New York, 1970, 
p. 80. 

Задача: 

Диск вращается вокруг оси 0 с угловой скоростью ω. Найти распределение напряже-
ний в диске. 
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Дано: 

E = 30 x 106 psi 

DENS = 0.02 lb sec2/in.4 

ν = 0.3 

h = l in. 

ω = 25 rad/sec 

R = 9 in. 

Сравнение результатов: 
 Элемент 1 (r = 0.5 in.) Элемент  9 (r = 8.5 in.) 
Напряжения σr psi σθ psi σr psi σθ psi 
Теория  416.37 416.91 45.12 203.16 
COSMOS/M  416.82 416.82 46.18 202.03 

 
Рис. FFES13-1 

FFES14: Реакции и отклонения консольной балки 

Тип: 

Статический расчет, элементы оболочки (SHELL4). 

Задача: 

Вычислить реакции и отклонения консольной балки, в свободном конце которой при-
ложена сосредоточенная сила. 

Дано: 

E = 30E6 psi 

h = 1 in. 
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L = 10 in. 

W = 4 in. 

P = 8 lb 

Сравнение результатов: 
 Теория COSMOS/M SHELL4 
Отклонения в свободном конце (узел 33)  2.667 x 10-4 2.667 x 10-4 
Полная сила реакции  8 lb 8 lb 
Полный момент реакции  80 lb-in. 80 lb-in. 

 
Рис. FFES14-1 

FFES15A, FFES15B, FFES15C, FFES15D, FFES15E, FFES15F: Отклонения криво-
линейной балки 

Тип: 

Статический расчет, 4-узловые элементы PLANE2D, 8-узловые элементы PLANE2D, 
6-узловые элементы TRIANG, 8-узловые элементы SOLID, 10-узловые элементы 
TETRA10 и 20-узловые элементы SOLID. 

Литература: 

Roark, R. J., "Formulas for Stress and Strain," 4th Edition, McGraw-Hill Book Co., New 
York, 1965, pp. 166. 

Задача: 

Криволинейная балка зажата в одном конце и подвергается действию поперечной рас-
пределенной нагрузки P, приложенной в другом конце. Найти отклонения в свобод-
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ном конце. 

Дано: 

E = 10E6 psi 

ν = 0.25 

R1 = 4.12 in. 

R2 = 4.32 in. 

t = 0.1 in. 

p = 50 lb/in2 (полная сила = 1 lb) 

Сравнение результатов: 

Теоретическое значение отклонений в свободном конце � 0.08854 in. 
Элементы Порядок COSMOS/M εy in. Ошибка (%) 
PLANE2D (4-узл.) (FFES15A)  Первый 0.07919 10.56 
PLANE2D (8-узл.) (FFES15B) Второй 0.08843 0.12 
TRIANG (6-узл.) (FFES15C)  Второй 0.08842 0.14 
TETRA10 (FFES15D)  Второй 0.08839 0.17 
SOLID (8-узл.) (FFES15E)  Первый 0.07852 11.32 
SOLID (20-узл.) (FFES15F)  Второй 0.08847 0.08 

 
Рис. FFES15-1 

FFES16: Расчет эллиптической мембраны 

Тип: 

Статический расчет, треугольные p-элементы в режиме плоских напряжений (TRI-
ANG). 

Литература: 
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Barlow, J., and Davis, G. A. O., "Selected FE Benchmarks in Structural and Thermal Analy-
sis," NAFEMS Rept. FEBSTA, Rev. 1, October, 1986, Test No. LG1. 

Задача: 

Вычислить напряжений в точке D эллиптической мембраны, подвергающейся дейст-
вию распределенной нагрузки, направленной вовне. 

Дано: 

E = 210 x 103 MPa 

ν = 0.3 

t = 0.1 

p = 10 MPa 

Сравнение результатов: 
 σy, в точке D 
Теория  92.7 
COSMOS/M  92.6 

 
Рис. FFES16-1 

FFES17: Расчет термальных напряжений плоской плиты 

Тип: 

Линейный расчет термальных напряжений, плоские элементы (PLANE2D). 

Задача: 
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Найти отклонения и термальные напряжения в плите, вызванные равномерным повы-
шением температуры на 100° F и 200° F. 

Дано: 

t = 0.1 in. 

x = 0.00001 in./in./°F 

ν = 0 

E = 30,000 ksi 

Сравнение результатов: 
 σx для всех элементов  

T = 100° F * 
σx для всех элементов  

T = 200° F 
Теория  - 30 ksi - 60 ksi 
COSMOS/M  - 30 ksi - 60 ksi 

* В файле исходных данных используется температура T = 200° F. Вам понадобится 
удалить приложенные температуры командой NTNDEL и приложить температуру 
100° F командой NTND. 

 
Рис. FFES17-1 

FFES18: Ферма с шарнирными соединениями 

Тип: 

Статический расчет, элементы стержня (TRUSS3D). 

Литература: 
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Beer, F. P., and Johnston, E. R., Jr., "Vector Mechanics for Engineers: Statics and Dynam-
ics," McGraw-Hill Book Co., Inc. New York, 1962, p. 47. 

Задача: 

Вес в 50 lb поддерживается тремя стержнями, закрепленными на потолке, как показа-
но на рисунке. Найти напряжения в стержнях. 

Дано: 

Площадь каждого стержня = 1 in2 

E = 30 x 106 psi 

Сравнение результатов: 
 σ1-4, psi σ2-4, psi σ3-4, psi 
Теория  10.40 31.20 22.90 
COSMOS/M  10.39 31.18 22.91 

 
Рис. FFES18-1 

FFES19: Расчет термальных напряжений фермы 

Тип: 

Линейный расчет термальных напряжений, элементы стержня (TRUSS2D). 

Литература: 

Hsieh, Y. Y. "Elementary Theory of Structures," Prentice-Hall, Inc., 1970, pp. 200-202. 

Задача: 



 64

Найти силы в звеньях фермы, показанной на рисунке, если температура верхнего поя-
са (элементы 13 и 14) повышается на 50° F. 

Дано: 

E = 30 x 106 psi 

Коэффициент термического расширения = 0.65 x 10-5/ °F 

L(ft )/A(in2) = 1 (для всех звеньев) 

Сравнение результатов: 
Силы в звеньях (kips) 

Звено Теория COSMOS/M Звено Теория COSMOS/M 
1 0 0 8 35.1 35.1 
2 0 0 9 0 0 
3 - 21.1 - 21.1 10 0 0 
4 0 0 11 + 35.1 + 35.1 
5 0 0 12 0 0 
6 - 28.1 - 28.1 13 0 0 
7 - 28.1 - 28.1 14 - 21.1 - 21.1 

 
Рис. FFES19-1 

FFES20: Напряжения и отклонения балки 

Тип: 

Статический расчет, элементы балки (BEAM3D). 

Литература: 

Timoshenko, S. P., "Strength of Materials, Part 1, Elementary Theory and Problems," 3rd 
Ed., D. Van Nostrand Co., Inc., New York , 1965, p. 98. 

Задача: 
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Стандартная балка двутаврового сечения шириной 30" лежит на опорах и подвергает-
ся действию равномерно распределенной нагрузки величиной 10,000 lb/ft. Найти 
максимальные напряжения в средней части балки и отклонения в середине балки. 

Дано: 

Площадь = 50.65 in2 

E = 30 x 106 psi 

p = 10,000 lb/ft 

Советы по моделированию: 

Используйте совместимые единицы длины. Поскольку задача симметрична, расчет 
выполняется только для половины модели. Распределенная нагрузка заменяется эк-
вивалентными силой и моментом, приложенными в узле 2. 

Сравнение результатов: 

В середине пролета (узел 3): 
 σmax, psi δ, in. 
Теория  11400.0 0.182 
COSMOS/M  11400.0 0.182 

 
Рис. FFES20-1 

FFES21A: Зажатая балка с вынужденными перемещениями 

Тип: 
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Статический расчет, элементы балки (BEAM3D). 

Литература: 

Gere, J. M. and Weaver, W. Jr., "Analysis of Framed Structures," D. Van Nostrand Co., 
1965. 

Задача: 

Найти силы в концах зажатой балки, вызванные перемещением правого конца на 1 in. 

Дано: 

E = 30 x 106 psi 

l = 80 in. 

A = 4 in2 

I = 1.33 in4 

h = 2 in. 

Аналитическое решение: 

Сила реакции: R = -12EI/L3 

Момент реакции: M = 6EI/L2 

Сравнение результатов: 
 Теория COSMOS/M 
Вынужденное перемещений (in.)  - 1.0 - 1.0 
Сила реакции (lb) - 937.5 - 937.5 
Момент реакции (lb-in.)  37,500.0 37,500.0 

 
Рис. FFES21A-1 
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FFES21B: Зажатая балка с вынужденными вращениями 

Тип: 

Статический расчет, элементы балки (BEAM3D). 

Литература: 

Gere, J. M. N. and Weaver, W. Jr., "Analysis of Framed Structures," D. Van Nostrand Co., 
1965. 

Задача: 

Найти силы в концах зажатой балки, вызванные вращением правого конца на 1 rad. 

Дано: 

E = 30 x 106 psi 

L = 80 in. 

A = 4 in2 

I = 1.3333 in4 

h = 2 in. 

Аналитическое решение: 

Сила реакции: R = -6EI/L2 

Момент реакции: M = 4EI/L 

Сравнение результатов: 
 Теория COSMOS/M 
Вынужденное вращение, rad  1 1 
Сила реакции  - 37,500 - 37,500 
Момент реакции  - 2,000,000 - 2,000,000 

 
Рис. FFES21B-1 
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FFES22: Отклонения подвеса 

Тип: 

Статический расчет, элементы стержня (TRUSS3D). 

Литература: 

Timoshenko, S. P., and MacCullough, Glesson, H., "Elements of Strength of Materials," D. 
Van Nostrand Co., Inc., 3rd edition, June 1949, p. 13. 

Задача: 

Конструкция, состоящая из двух одинаковых стальных стержней, каждый длиной 15 
ft, с шарнирными опорами, подвергается действию вертикальной силы P. Найти силы 
в звеньях AB и BC, а также вертикальные отклонения точки B. 

Дано: 

P = 5000 lbs 

θ = 30° 

Площадь поперечного сечения = 0.5 in2 

AB = BC = 15 ft 

E = 30 x 106 psi 

Сравнение результатов: 
 Теория COSMOS/M 
Вертикальные отклонения точки B,  in  0.12 0.12 
Силы в звеньях AB и BC, lbs  5000 5000 

 
Рис. FFES22-1 

FFES23: Расчет статически неопределимых сил реакции 

Тип: 

Статический расчет, элементы стержня (TRUSS3D). 
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Литература: 

Timoshenko, S. P., "Strength of Materials, Part 1, Elementary Theory and Problems," 3rd 
edition, D. Van Nostrand Co., Inc., 1956, p. 26. 

Задача: 

Стержень призматического сечения с зафиксированными концами нагружен двумя 
продольными силами F1 и F2. Найти силы реакции R1 и R2. 

Дано: 

a = b = 0.3 L 

L = 10 in. 

F1 = 2F2 = 1000 lb 

E = 30 x 106 psi 

Сравнение результатов: 
 R1 lbs. R2 lbs 
Теория  900 600 
COSMOS/M  900 600 

 
Рис. FFES23-1 

FFES24A, FFES24B: Ферма с вертикальной нагрузкой 

Тип: 

Статический расчет, элементы стержня (TRUSS3D). 

Литература: 
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Timoshenko, S. P. and Young, D. H. "Theory of Structures," end Ed., McGraw-Hill, New 
York, 1965, pp. 330-331. 

Задача: 

Простая трехмерная ферма, показанная на рисунке, состоит из двух панелей ABCD и 
ABEF, прикреплена к вертикальной стене в точках C, D, E и F, панель ABCD лежит в 
горизонтальной плоскости. Все стержни имеют одинаковые площадь поперечного 
сечения A, и модуль упругости E. 

Вычислить: 

1. Продольные силы, вызываемые в избыточном стержне AD вертикальной нагрузкой 
P = 1 kip, приложенной в точке A (FFES24A). 

2. Термальные силы, вызванные в стержне AD равномерным повышением температу-
ры на 50° F (FFES24B). 

Дано: 

E = 30 x 106 psi 

α = 6.5 x 10-6/°F 

A = 1 in2 

L = 4 ft 

Сравнение результатов: 

В элементе 2: 
 FFES24A FFES24B 
Теория  56.0 lb -1259.0 lb 
COSMOS/M  55.92 lb -1292.4 lb 

 
Рис. FFES24-1 
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FFES25: Расчет термальных напряжений рамы 

Тип: 

Линейный расчет термальных напряжений, элементы балки (BEAM3D). 

Литература: 

Rygol, J., "Structural Analysis by Direct Moment Distribution," Gordon and Breach Science 
Publishers, New York, 1968, pp. 292-294. 

Задача: 

Неправильная рама подвергается действию разных температур. Найти концевые мо-
менты в звеньях. 
Параметры звеньев 
Звено d (ft) b (ft) Ar-r (ft) lt-t (ft) 

1 1.5 1.5 2.25 0.422 
2 2.25 1.25 2.8125 1.187 
3 2.0 1.5 3.0 1.0 
4 2.5 1.25 3.125 1.628 
5 2.0 1.5 3.0 1.0 

Дано: 

E = 192857 tons/ft2 

α = 0.00001 ft/ft°C 

Сравнение результатов: 

Моменты (lb-in): 
Звено COSMOS/M Теория 

1 - 17.96 - 17.96 
2 + 17.96  

- 42.87 
+ 17.96  
- 42.96 

3 + 38.73  
- 41.92 

+ 38.64  
- 41.96 

4 + 84.79  
- 82.61 

+ 84.92  
- 82.61 

5 - 57.50  
+ 82.61 

- 57.40  
+ 82.61 
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Рис. FFES25-1 

 
Рис. FFES25-2 

FFES26: Расчет термальных напряжений простой рамы 

Тип: 

Линейный расчет термальных напряжений, элементы балки (BEAM3D). 

Задача: 

Найти перемещения и концевые силы в раме, показанной на рисунке, вызванные уве-
личением температуры в узлах и градиентами температуры, описанными ниже. 

Дано: 

E = 30,000 kips/in2 

α = 0.65 x 10 in./in./°F 
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 Элемент 1 Элемент 2 
Разность температур по направлению S  72° F 0 
Разность температур по направлению T  0 13.5° F 

Сравнение результатов: 

Перемещения в узле 2 (in.): 
 δx δy 
Теория  - 0.0583 0.1157 
COSMOS/M  - 0.0583 + 0.1168 

 
Рис. FFES26-1 

FFES27: Расчет рамы с комбинированными нагрузками 

Тип: 

Статический расчет, элементы балки (BEAM3D). 

Литература: 

Laursen, Harold I., "Structural Analysis," McGraw-Hill Book Co., Inc., New York, 1969, pp. 
310-312. 

Задача: 

Найти силы в звеньях рамы, подвергающейся действию нагрузок, показанных на ри-
сунке. Используются два отдельных вариантов нагрузки, представляющих распреде-
ленную нагрузку и сосредоточенную силу. Исходные данные записаны таким 
образом, что варианты нагрузки рассчитываются по отдельности, а затем комбини-
руются для получения окончательного результата. 

Дано: 

Iyy = Izz = 0.3215 ft4 
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I = 0.6430 ft4 

A1 = 3.50 ft2 

A2,3 = 4.40 ft3 

A4 = 2.79 ft2 

E = 432 x 104 K/ft2 

Сравнение результатов: 

Результаты приведены на рисунке; значения, полученные в COSMOS/M, приведены в 
скобках. 

 
Рис. FFES27-1 

 
Рис. FFES27-2 
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FFES28: Ферма с сосредоточенной нагрузкой 

Тип: 

Статический расчет, элементы стержня (TRUSS2D). 

Литература: 

Hsieh, Y. Y., "Elementary Theory of Structures," Prentice-Hall Inc., 1970, pp. 162-163. 

Задача: 

Вычислить реакции и вертикальное отклонение точки 2 фермы, подвергающейся дей-
ствию распределенной нагрузки. 

Дано: 

E = 30,000 kips/in2 

L (ft)/A(in.) = l (для всех звеньев) 

P = 64 kips 

Сравнение результатов: 
 Теория COSMOS/M 
Отклонение точки 2  0.006733 in. 0.006733 in. 
Реакция в узле 1  48 K 48 K 
Реакция в узле 5  16 K 16 K 

 
Рис. FFES28-1 
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Приложение A. 
Устранение неполадок 

Введение 

В данном приложении приведены сообщения об ошибках, выводимые статическим 
модулем COSMOS/FFE, упорядоченные по алфавиту. Также приведены объяснения и 
рекомендации по устранению. 

Неполадка: Bonding is not supported 

(Скрепление не поддерживается) 

В модели вы использовали «скрепление» двух или более тел. В текущей версии стати-
ческого модуля FFE «скрепление» не поддерживается. Используйте модуль STAR 
или измените КЭ-сеть так, чтобы она была совместимой. 

Неполадка: Coordinate system <number> is referenced but not defined 

(Координатная система <номер> используется, но не определена) 

Задайте недостающую координатную систему и повторно запустите расчет, или изме-
ните исходные данные так, чтобы эта координатная система не использовалась. 

Неполадка: Coupling is not supported 

(Уравнения зависимости не поддерживаются) 

Вы задали использование уравнений зависимостей командами CPDOF, CPCNS или 
CPEQN. В текущей версии статического модуля FFE использование уравнений зави-
симости не поддерживается. Используйте модуль STAR или удалите уравнения  за-
висимости. 

Неполадка: Crack elements are not supported 

(Элементы трещины не поддерживаются) 

В модели вы использовали элементы CRACK. В текущей версии статического модуля 
FFE элементы CRACK не поддерживаются. Используйте модуль STAR или удалите 
элементы CRACK. 

Неполадка: Degenerate element <number> 

(Вырожденный элемент <номер>) 

В модели обнаружены вырожденные элементы. Вырожденными называются одномер-
ные элементы с нулевой длиной, плоские элементы с нулевой площадью и объемные 
элементы в нулевым объемом. Используйте команду ECHECK (Meshing > ELEMENTS 
> Check Element), чтобы исправить эту неполадку и автоматически удалить одномер-
ные элементы, длина которых меньше PTTOL, плоские элементы, площадь которых 
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меньше PTTOL в квадрате и объемные элементы, объем которых меньше PTTOL в 
кубе. Допуск точек задается в команде PTTOL (Geometry > POINTS > Merge Toler-
ance). 

Неполадка: Element <number> has unsupported type 

(Элемент <номер> имеет неподдерживаемый тип) 

Элемент связан с группой элементов, которая не поддерживается текущей версией 
статического модуля FFE. Используйте модуль STAR, или измените группу элемен-
тов. 

Неполадка: Element <number> is pyramid shaped, which is not supported 

(Элемент <номер> имеет неподдерживаемую форму пирамиды) 

Элемент принадлежит к группе элементов SOLID. Узлы, определяющие одну из гра-
ней элемента, переместились в одну точку. Такие элементы не поддерживаются в те-
кущей версии статического модуля FFE. Такой элемент мог быть задан вручную или 
получен при генерации КЭ-сети для тела с вырожденной гранью. Удалите КЭ-сеть, 
используйте элементы TETRA4 или TETRA10, и используйте автоматическую гене-
рацию КЭ-сети вместо параметрической. Элементы, имеющие форму призмы, под-
держиваются. 

Неполадка: Error while closing a temporary file 

(Ошибка при закрытии временного файла) 

При закрытии временного файла произошла ошибка ввода-вывода. 

Неполадка: Error while positioning a temporary file 

(Ошибка при изменении позиции во временном файле) 

При чтении из временного файла произошла ошибка ввода-вывода. 

Неполадка: Error while reading file <filename> 

(Ошибка чтения файла <имя_файла>) 

При чтении из файла, являющегося частью базы данных COSMOS/M, произошла 
ошибка ввода-вывода. Этот файл может быть поврежден. Проверьте целостность же-
сткого диска, воссоздайте модель, создав новую задачу и использовав команду FILE 
(File > Load...), и попытайтесь еще раз. 

Неполадка: Error while reading from a temporary file 

(Ошибка при чтении из временного файла) 

При чтении из временного файла произошла ошибка ввода-вывода. 
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Неполадка: Error while writing to a temporary file 

(Ошибка записи во временный файл) 

При записи во временный файл произошла ошибка. Проверьте доступность дискового 
пространства, целостность системы, в особенности жесткого диска. Воссоздайте базу 
данных и попытайтесь еще раз. 

Неполадка: Error while writing to file <filename> 

(Ошибка при записи в файл <имя_файла>) 

При записи в файл произошла ошибка. Проверьте целостность системы, в особенности 
жесткого диска. Воссоздайте базу данных и попытайтесь еще раз. 

Неполадка: Excessive warping in element <number> 

(Слишком большой перекос в элементе <номер>) 

Перекос в указанном квадратном элементе оболочки слишком большой и приведет к 
ошибочным результатам. Удалите существующую КЭ-сеть и сгенерируйте новую из 
меньших четырехугольных или треугольных элементов. Если вы будете использо-
вать треугольные элементы, то переопределите группу элементов на SHELL3. 

Неполадка: File <filename> does not contain necessary data 

(В файле <имя_файла> не содержатся необходимые данные) 

Указанный файл не содержит необходимых данных в необходимом формате. Возмож-
но файл был поврежден, перезаписан или создан другой версией COSMOS/M. 

Неполадка: File <filename> has invalid format 

(Неправильный формат файла <имя_файла>) 

Формат указанного файла не соответствует ожидаемому. Возможно файл был повреж-
ден, перезаписан или создан другой версией COSMOS/M. 

Неполадка: Fluid option is not supported (element <number>) 

(Опция жидкости не поддерживается (элемент <номер>)) 

Указанный элемент принадлежит к группе элементов, для которой была указана опция 
жидкости. Данная опция не поддерживается в текущей версии. Переопределите 
группу элементов или используйте модуль STAR. 

Неполадка: Improper axisymmetric model 

(Неправильная осесимметричная модель) 

Осесимметричная модель задана неправильно. Осесимметричные элементы должны 
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быть заданы в глобальной плоскости XY, где ось Y представляет ось симметрии. 

Неполадка: Improper mesh near element <number> 

(Неправильная КЭ-сеть возле элемента <номер>) 

Возле указанного элемента КЭ-сеть несовместима. Это может быть вызвано непра-
вильным «слиянием» узлов, неправильной параметрической генерацией КЭ-сети из 
четырехгранных элементов или неправильными элементами, созданными вручную. 

Неполадка: Improper mesh, properties, or boundary conditions 

(Неправильная КЭ-сеть, свойства или граничные условия) 

Либо КЭ-сеть, либо свойства материала, либо граничные условия были заданы непра-
вильно. Используйте команду R_CHECK (Analysis > Run Check). Также выведите и 
изучите свойства материала и граничные условия. 

Неполадка: Incompatible element groups 

(Несовместимые группы элементов) 

Созданная КЭ-сеть содержит элементы, группы которых несовместимы друг с другом. 
Попробуйте использовать другие группы элементов, чтобы степени свободы были 
совместимы. 

Неполадка: Internal error # <number> 

(Внутренняя ошибка <номер>) 

Произошла внутренняя ошибка. Запишите номер и сообщите в S.R.A.C. 

Неполадка: Invalid combination of first and second order elements 

(Неправильная комбинация элементов первого и второго порядков) 

Элементы первого и второго порядков соединены таким образом, что получились не-
правильные общие ребра. Пример: соединение элементов TETRA4 с элементами 
TETRA10. Используйте команду ECHANGE (Meshing > Element Order), чтобы испра-
вить это, увеличив порядок элементов первого порядка или понизив порядок элемен-
тов второго. Также рекомендуется, но не обязательно, изменить группу элементов. 

Неполадка: Invalid order of nodes for element <number>, try ECHECK command to fix 

(Неправильный порядок узлов в элементе <номер>, попробуйте команду ECHECK) 

Узлы, определяющие указанный элемент, заданы неправильно. Отобразите элементы с 
включенной нумерацией узлов, и используйте команду ELIST (Edit > LIST > 
Elements), чтобы изучить порядок задания узлов. Такая ошибка может произойти, ес-
ли элементы были заданы вручную командой EL (Meshing > ELEMENTS > Define 
Element). Используйте команду ECHECK (Meshing > ELEMENTS > Check Element), ес-
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ли элемент вырожденный. 

Неполадка: Invalid Poisson's ratio (<wrong_value>) in material set <number> 

(Неправильное отношение Пуассона (<значение>) в наборе свойств материала <но-
мер>) 

Для указанного набора свойств материала задано неправильное значение отношения 
Пуассона. Задайте новое значение, большее нуля, но меньшее 0.5. Если вы исполь-
зуете гиперупругий материал, то необходимо использовать модуль нелинейного кон-
струкционного расчета NSTAR. 

Неполадка: No temperature data found for the time step number <number> 

(Не найдены данные температуры для временного шага <номер>) 

Вы используете термальную нагрузку со считыванием результатов термального расче-
те устойчивого или переходного состояний. Для задания временного шага в случае 
термального расчета переходного состояния должна быть использована команда 
TEMPREAD (LoadsBC > LOAD OPTIONS > Read Temp as Load). Проверьте исходные 
данные и повторно выполните термальный расчет, если необходимо. 

Неполадка: Not enough boundary conditions 

(Недостаточно граничных условий) 

Граничные условия модели не могут обеспечить поддержку модели, что приведет к 
бесконечным перемещениям или вращениям по одному или более направлениям. 
Добавьте или измените граничные условия по перемещениям, чтобы стабилизиро-
вать модель и повторите расчет. 

Неполадка: Orthotropic material properties are not supported 

(Ортотропные свойства материала не поддерживаются) 

Был задан набор свойств материала, использующий ортотропный материал. В текущей 
версии поддерживаются только изотропные материалы. Измените свойства материа-
ла, или используйте модуль STAR. 

Неполадка: Out of memory or swap space 

(Не достаточно памяти или файла подкачки) 

Доступной виртуальной памяти недостаточно для решения задачи. Если вы исполь-
зуете UNIX-систему, свяжитесь с системным администратором. 

Неполадка: Pure membrane or shear panel analysis is not supported 

(Расчет чистой мембраны или срезовой панели не поддерживается) 

Была задана группа элементов, в которой был указан расчет чистой мембраны или 
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срезовой панели. Для элементов оболочки поддерживаются только мембранные и из-
гибающие эффекты по умолчанию. Переопределите группу элементов и используйте 
опции по умолчанию. 

Неполадка: Second order shell elements are not supported 

(Элементы оболочки второго порядка не поддерживаются) 

Элементы оболочки второго порядка (SHELL6 и SHELL9) не поддерживаются. Ис-
пользуйте элементы SHELL3.  

Неполадка: Stress output in the local coordinate systems is not supported 

(Вывод напряжений в локальной координатной системе не поддерживается) 

Вы запросили вывод напряжений в локальной координатной системе. В текущей вер-
сии эта опция не поддерживается. Все напряжения вычисляются в глобальной Декар-
товой координатной системе. Напряжения в других координатных системах 
доступны на этапе постпроцессинга при использовании команды ACTSTR (Results > 
PLOT > Stress). 

Неполадка: There is no active load case to solve 

(Нет активного варианта нагрузки) 

Отсутствует активный вариант нагрузки. Либо вы не задали никаких нагрузок, либо 
вы деактивировали все варианты нагрузки командой LCSET (Analysis > STATIC > Ac-
tivate Load Case). Задайте нагрузки или активизируйте существующий вариант на-
грузки. 

Неполадка: Thermal analysis results don't correspond to the current model 

(Результаты термального расчета не соответствуют текущей модели) 

Вы используете термальную нагрузку, считываемую из результатов термального рас-
чета, но статический модуль FFE определил, что файлы результатов термального 
расчета не соответствуют текущей модели. Это может быть вызвано тем, что после 
выполнения термального расчета модель была изменена (например, добавлены или 
удалены элементы), или файл имя_задачи.HTO был создан другой версией модуля 
термального расчета COSMOS/M. Проверьте модель и попытайтесь выполнить рас-
чет еще раз FFE. 

Неполадка: Unable to create a temporary file 

(Невозможно создать временный файл) 

Статический модуль FFE не может создать временный файл. Проверьте целостность 
жесткого диска и наличие дискового пространства. 

Неполадка: Unable to create file <filename> 
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(Невозможно создать файл <имя_файла>) 

Статический модуль FFE не может создать указанный файл. Проверьте целостность 
жесткого диска и наличие дискового пространства. 

Неполадка: Unable to open file <filename> 

(Невозможно открыть файл <имя_файла>) 

Статический модуль FFE не может открыть указанный файл, являющийся частью базы 
данных COSMOS/M. Возможно этот файл был удален. Проверьте целостность диска; 
воссоздайте модель. 

Неполадка: Unable to open problem database 

(Невозможно открыть базу данных задачи) 

Статический модуль FFE не может открыть базу данных задачи. Проверьте, что база 
данных находится там, где указано и что используется правильная версия. Также 
проверьте целостность жесткого диска и наличие дискового пространства. 

Неполадка: Unexpected end of file while reading <filename> 

(Неожиданный конец файла при чтении <имя_файла>) 

При считывании данных из файла был обнаружен символ конца файла до окончания 
считывания всех необходимых данных. Проверьте исходные данные, исправьте 
ошибки, если таковые имеются. Попробуйте воссоздать файл, проверьте целостность 
системы; воссоздайте базу данных. 

Неполадка: Unsupported element type 

(Тип элементов не поддерживается) 

Вы задали группу элементов, которая еще не поддерживается. Попробуйте использо-
вать эквивалентную группу элементов или используйте модуль STAR. 

Неполадка: You are not authorized to use this type of analysis 

(Вы не можете использовать этот тип расчета) 

Программа PRODUCT_INFO (Control > MISCELLANEOUS > Product Info) выведет спи-
сок модулей, лицензией на использование которых вы обладаете. Свяжитесь с 
S.R.A.C. 

Неполадка: Zero or negative thickness for element <number> 

(Нулевая или отрицательная толщина элемента <номер>) 

Толщина указанного элемента равна нулю или отрицательна. Используйте команду 
ELIST (Edit > LIST > Elements), чтобы вывести данные групп элементов и наборов 
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вещественных констант, связанных с ними, после чего используйте команду RCONST 
(Propsets > Real Constant), чтобы переопределить толщину. 

Неполадка: Zero or negative Young modulus in material set <number> 

(Нулевое или отрицательное значения модуля Юнга в наборе свойств материала <но-
мер>) 

Значение модуля Юнга в указанном наборе свойств материала равно нулю или отри-
цательно. Используйте команду MPROP (Propsets > Material Property), чтобы задать 
новое значение EX. 



 84

Термальный расчет  
Глава 1. 
Введение  

Введение  

Термальный модуль COSMOS/FFE � КЭ-расчетная программа, используемая для мо-
делирования термальных система. Программа использует новую технологию, осно-
ванную на иерархическом p-подходе вместе с новым итерационным методом для 
разреженных матриц, что позволяет сократить время решения и требования к вычис-
лительным ресурсам. 

Программа может рассчитывать линейные и нелинейные задачи теплопереноса устой-
чивого и переходного состояния с граничными условиями по конвекции и излучению 
в одном, двух и трех измерениях. 

Теория 

Главное уравнение теплопереноса в термальном модуле FFE имеет следующий вид: 

 

ρC∂T/∂t = ∂/∂x(kx∂T/∂x) + ∂/∂y(ky∂T/∂y) + ∂/∂z(kz∂T/∂z) + Q (1-1) 

где: 

T = температура 

t = время 

ρ = плотность 

C = удельная теплота 

kx, ky, kz = теплопроводности по глобальным направлениям X, Y и Z, соответственно 

Q = скорость объемного выделения 

Граничные условия 

В термальном модуле FFE можно использовать следующие граничные условия и на-
грузки. 

Предписанная температура 

Предписанные температуры можно задавать в любой части границы модели. 
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Ts = To   (1-2) 

Ts = Температура поверхности 

To = Заданная температура 

Конвекция 

Конвекция может быть приложена к любой части границы модели. 

Тепловой поток = q = hc (Ts - T∞) (1-3) 

hc = Коэффициент конвекции 

Ts = Температура поверхности 

T∞ = Температура среды 

Излучение 

Излучение может быть приложено к любой части границы модели. 

Тепловой поток = q = σε(Ts
4 - T∞4)  (1-4) 

σ = Постоянная Стефана-Больцмана 

ε = Излучающая способность (эмиссивность) 

Ts = Температура поверхности 

T∞ = Температура среды 

Приложенный тепловой поток 

Тепловой поток может быть приложен к любой части границы модели. 

q = Приложенный тепловой поток = - K(∂T/∂n)s (1-5) 

K = ТеплопроводностьThermal conductivity 

(∂T/∂n)s = Нормальный градиент температуры на поверхности 

Глава 2. 
Возможности 

Введение 

Ниже приведены некоторые возможности термального модуля FFE. 
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Расчетные возможности 
! Линейные и нелинейные задачи теплопереноса устойчивого и переходного со-
стояний 

! Свойства материала, зависящие от температуры 
! Источники и поглотители тепла, зависящие от времени или температуры 
! Граничные условия, зависящие от температуры или времени: 

- Тепловой поток 
- Конвекция 
- Излучение 

! Предписанные температуры, зависящие от времени 
! Элементы первого и второго порядка 
! Возможность использования полученного распределения температур в конст-
рукционном расчете 

! Возможность продолжения расчета задач переходного состояния 

Внутреннее тепловыделение 

Внутреннее тепловыделение может быть задано в любом узле или элементе модели. 

Свойства, зависящие от температуры или времени 

Для задания зависимости свойств материала, а также коэффициентов конвекции, ско-
рости тепловыделения, эмиссивности поверхности и тепловых потоков от темпера-
туры используются температурные кривые. Для задания зависимости таких 
параметров, как конвекция, температура и т.д. от времени используются временные 
кривые. 

Коэффициенты конвекции, зависящие от температуры, вычисляются на основе сред-
них пленочных температур (Ts + T∞)/2. Эмиссивности, зависящие от температуры, 
вычисляются на основе температур поверхности. 

Расчет термальных напряжений 

После завершения термального расчета полученное распределение температуры мо-
жет быть использовано для вычисления термальных напряжений в конструкции в 
модуле STAR. 

Ограничения по размерам 

При установке программы пользователь может выбрать версию, поддерживающую 
либо 64,000, либо 256,000 узлов/элементов. Эти ограничения представляют собой 
максимальные метки узлов и элементов, которые можно создать в GEOSTAR. По-
скольку ограничение на число узлов в расчетном модуле определяется ресурсами 
машины, вы можете создать модель с 64,000 узлами в GEOSTAR и использовать 
элементы второго порядка во время расчета. В таблице приведены ограничения на 
число некоторых примитивов. Более подробная информация об ограничениях приве-
дена в Руководстве пользователя. 
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Таблица 2-1. Ограничения термального расчета в COSMOS/M 

Примитив Ограничение 
Временные кривые 
Точек для задания временной кривой 

100  
5000 

Температурные кривые 
Точек для задания температурной кривой 

100  
5000 

Временных шагов 6000 

Глава 3. 
Библиотека элементов 

Введение 

Термальный модуль COSMOS/FFE предоставляет обширную библиотеку элементов, 
которая подойдет для моделирования всех практических задач теплопереноса. Эле-
менты моделируют поведение одно-, двух- и трехмерных задач в линейном и нели-
нейном термальных расчетах устойчивого и переходного состояний. В таблице 
приведены элементы, доступные в термальном модуле COSMOS/FFE. 

Таблица 3-1. Элементы, доступные в термальном расчете  

Тип элемента Имя элемента Порядок 
Двухмерная упругая балка BEAM2D  Первый 
Трехмерная упругая балка  BEAM3D  Первый 
Конвекционный соединитель CLINK  . . . 
4/8-узловой плоский и осесимметричный элемент PLANE2D  Первый/второй 
Радиационный соединитель RLINK  . . . 
3-узловой элемент тонкостенной оболочки SHELL3  Первый 
3-узловой элемент толстостенной оболочки SHELL3T Первый 
4-узловой элемент тонкостенной оболочки SHELL4  Первый 
4-узловой элемент толстостенной оболочки SHELL4T  Первый 
8/20-узловой объемный элемент SOLID  Первый/второй 
4-узловой четырехгранный элемент TETRA4  Первый 
10-узловой четырехгранный элемент TETRA10  Второй 
3/6-узловой плоский и осесимметричный элемент TRIANG  Первый/второй 
Двухмерный элемент стержня TRUSS2D  Первый 
Трехмерный элемент стержня TRUSS3D Первый 

Вышеперечисленные элементы задаются с помощью команды EGROUP (Propsets > 
Element Group). В таблице 3-2 приведены команды, используемые для управления ат-
рибутами элементов. В скобках приведены пути меню для команд. 

Таблица 3-2. Команды для управлениям группами элементов 

Команда Функция Комментарии 
EGROUP  
(Propsets > Element Group)  

Задает группу элементов и связанные с 
ней опции.  

Максимально допустимое число 
групп элементов в модели � 20. 

EPROPSET  
(Propsets > New Property Set)  

Присваивает существующие группу 
элементов, наборы свойств материала и 
вещественных констант и координат-
ные системы элементы создаваемым 
элементам. 

 

EPROPCHANGE  
(Propsets > Change El-Prop)  

Изменяет связи между группами эле-
ментов, наборами свойств материала и 
вещественных констант. 

 

EGLIST  
(Edit > LIST > Element Groups) 

Выводит указанные группы элементов 
и связанные с ними опции.  

Вся информация, выводимая на 
экран, может быть перенаправ-
лена в текстовый файл с помо-
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щью команды LISTLOG (Control 
> MISCELLANEOUS > List Log). 

EGDEL  
(Edit > DELETE > Element 
Groups)  

Удаляет указанные группы элементов и 
связанные с ними опции. 

 

Элементы, перечисленные в таблице 3-1, можно классифицировать по их размерности. 
Элементы TRUSS2D, TRUSS3D, BEAM2D и BEAM3D � линейные элементы, ис-
пользуемые в одномерных задачах на теплоперенос. Элементы PLANE2D, TRIANG, 
SHELL3, SHELL4, SHELL3T и SHELL4T используются в двухмерных задачах. Эле-
менты SOLID, TETRA4 и TETRA10 используются в трехмерных задачах. Элементы 
CLINK и RLINK являются линейными элементами, но используются во всех тер-
мальных задачах. 

Каждый элемент имеет различные опции расчета и моделирование (не больше вось-
ми), обозначенные OP1,�, OP8. Когда вы выполняете команду EGROUP, значения оп-
ций указываются в приглашениях, которые предоставляют их физическую 
интерпретацию для выбранного элемента. 

ПРИМЕЧАНИЕ: Порядок элементов, которые будут использованы в расчете, управ-
ляется с помощью команды A_FFETHERMAL (Analysis > HEAT TRANSFER > FFE 
Thermal Options) а не числом узлов, использованных на этапе препроцессинга для 
элементов TRIANG, PLANE2D, SOLID, TETRA4 и TETRA10. Возможны четыре ва-
рианта:  
! Использование элементов первого порядка для элементов первого порядка в GEOSTAR 
! Использование элементов второго порядка для элементов первого порядка в GEOSTAR 
! Использование элементов первого порядка для элементов второго порядка в GEOSTAR 
! Использование элементов второго порядка для элементов второго порядка в GEOSTAR 

На рисунке показано графическое представление элементов, доступных в термальном 
модуле COSMOS/FFE. Подробное описание элементов приведено в Главе 4 Руково-
дства пользователя COSMOS/M (Том 1). 
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Рис. 3-1. Элементы, доступные в термальном модуле FFE  

Глава 4. 
Исходные данные 

Введение 

Для успеха любого КЭ-расчета критично правильное моделирование и задание на-
строек расчета. Независимо от типа расчета для численного решения необходима 
полная информация о рассматриваемой модели. КЭ-модель, передаваемая на расчет, 
должна содержать все данные, необходимые для каждого шага численного решения � 
геометрию, элементы, нагрузки, граничные условия, решения системы уравнений, 
визуализации и вывода результатов и так далее. В данной главе иллюстрируется про-
цедура создания модели для расчета в термальном модуле COSMOS/FFE. 

Полное описание процедур пре- и постпроцессинга в GEOSTAR приведено в Руково-
дстве пользователя COSMOS/M (Том 1). Данная глава не повторяет эти описания, а 
представляет краткий обзор команд, относящихся к термальному модулю COS-
MOS/FFE.  

Полное описание всех команд приведено в Справке программы и в Справочнике ко-
манд COSMOS/M (Том 2). 

Цикл моделирования и расчета в термальном модуле COSMOS/FFE 

Процедура КЭ-расчета состоит из следующих основных шагов: 
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! Создание геометрии задачи. 
! Генерация КЭ-сети для геометрии с использованием соответствующего типа(ов) 
элементов. 

! Приложение ограничений. 
! Задание нагрузок. 
! Задание свойств материала и вещественных констант. 
! Передача законченной модели на расчет. 
! Интерпретация результатов. 

Схематически эти шаги можно представить, как показано на рисунке. 

 
Рис. 4-1. Процедура КЭ-моделирования и расчета 

Препроцессингом называются операции, выполняемые вами до выполнения расчета. 
Сюда входит создание геометрии модели, генерация КЭ-сети, приложение нагрузок и 
граничных условий, а также задание другой необходимой информации. Под расчетом 
в схеме понимается задание настроек расчета и выполнение собственно расчета. 
Постпроцессингом называются операции в графической среде, выполняемые с ре-
зультатами расчета для облегчения интерпретации результатов и их понимания. 

В таблице приведена сводка команд, используемых для задания групп элементов, 
свойств материала, нагрузок и граничных условий, настроек расчета и настроек вы-
вода результатов. 

Таблица 4-1. Команды для выполнения термального расчета 

Функция Путь меню Краткое имя команды 
Задание свойств Propsets 

 > Element Group  
 > Material Property  
 > Real Constant  
 > Pick Material Lib  
 > User Material Lib  
 > Material Browser  
 > AISC Sect Table  
 > Change El-Prop  
 > New Property Set  
 > Beam Section 

. . . 
EGROUP  
MPROP  
RCONST  
PICK_MAT  
USER_MAT  
R_MATLIB  
PICK_SEC  
EPROPCHANGE  
EPROPSET  
BMSECDEF 

Задание нагрузок и 
граничных условий 

LoadsBC  
 > THERMAL  
   > TEMPERATURE  
   > NODAL HEAT  
   > ELEMENT HEAT  
   > HEAT FLUX  
   > CONVECTION  
   > RADIATION 

 . . .  
. . .  
NT_ команды задания узловых температур *  
Q_ команды задания узлового тепловыделения *  
QE_ команды задания тепловыделения на элементах *  
HX_ команды задания теплового потока *  
CE_ команды задания конвекции *  
RE_ команды задания излучения *  

Проверка модели Meshing  . . .  
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 > ELEMENTS  
   > Check Element  
Analysis  
 > Data Check  
  > Run Check  

. . .  
E_CHECK  
. . .  
DATA_CHECK  
R_CHECK  

Задание настроек рас-
чета  

Analysis  
 > HEAT TRANSFER  
  > FFE Thermal Options  

. . .  

. . .  
A_FFETHERMAL 

Задание настроек вы-
вода результатов 

Analysis  
 > HEAT TRANSFER  
   > Thermal Output Options  
 > OUTPUT OPTIONS  
   > Set Print Options 

. . .  

. . .  
HT_OUTPUT  
. . .  
PRINT_OPS 

Выполнение статиче-
ского расчета 

Analysis  
 > HEAT TRANSFER  
   > Run Thermal Analysis 

. . .  

. . .  
R_THERMAL  

Постпроцессинг Results  
 > PLOT  
 > Thermal  
 > LIST  
   > Thermal Result  
 > EXTREMES  
   > Min/Max Temperature  

. . .  
ACTTEMP  
TEMPPLOT  
. . .  
TEMPLIST  
. . .  
TEMPMAX 

* Более подробная информация об этих командах приведена в Справочнике команд 

Температурные и временные кривые 

Температурные и временные кривые используются для задания зависимостей свойств 
от температуры и времени, соответственно. Чтобы использовать температурную или 
временную кривую, необходимо выполнить следующие шаги: 

! Задайте температурную или временную кривую с помощью команды CURDEF 
(LoadsBC > FUNCTION CURVE > Time/Temp Curve). Заданная кривая будет ав-
томатически активизирована. 

! Задайте необходимое свойство (граничное условие, нагрузку, свойство материа-
ла и т.д.). 

! Деактивируйте кривую, используя команду ACTSET (Control > ACTIVATE > Set 
Entity), чтобы не связать ошибочно эту кривую со свойствами, которые будут 
заданы позднее. 

Например, нижеприведенные команды задают теплопроводность, зависящую от тем-
пературы. С помощью команды CURDEF (LoadsBC > FUNCTION CURVE > 
Time/Temp Curve) задайте температурную кривую 1, а затем выполните следующую 
последовательность команд: 
Control Panel: Control > ACTIVATE > Set Entity 
Set Label > Temperature Curve 
Выберите Continue  
Load case set number > 1 
Примите значения 
Control Panel: Propsets > Material Property 
Material Property Set [1] > 
Material Property Name > KX 
Thermal Conductivity Property value [0.0] > 1.0 
Примите значения 
Control Panel: Control > ACTIVATE > Set Entity 
Set Label > Temperature Curve 
Выберите Continue 
Load case set number > 0 
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Примите значения 

Расчет термальных напряжений 

После выполнения термального расчета полученное распределение температуры мож-
но использовать для вычисления термальных напряжений в материале. Для вычисле-
ния термальных напряжений необходимо выполнить следующие шаги: 

! Выполните термальный расчет  
! Активизируйте учет термальной нагрузки в команде A_FFESTATIC (Analysis > 

STATIC > FFE Static Options)  
! Если вы выполняли термальный расчет переходного состояния, то используйте 
команду TEMPREAD (LoadsBC > LOAD OPTIONS > Read Temp as Load), чтобы 
указать временной шаг, распределение температур на котором будет использо-
вано для вычисления термальных напряжений 

! Выполните статический расчет, выполнив команду R_STATIC (Analysis > 
STATIC > Run Static Analysis)  

Настройки термального расчета 

Команда A_FFETHERMAL 

(Control Panel: Analysis > HEAT TRANSFER > FFE Thermal Ops) 

Команда A_FFETHERMAL (Analysis > HEAT TRANSFER > FFE Thermal Options) задает 
настройки термального расчета, выполняемого в термальном модуле FFE. Команда 
A_THERMAL (Analysis > HEAT TRANSFER > Thermal Analysis Options) задает на-
стройки термального расчета, выполняемого в модуле HSTAR. 

Описание приглашений 
analysis-option  Тип выполняемого расчета 

EQ. S Расчет устойчивого состояния  
EQ. T Расчет переходного состояния 
(по умолчанию 2) 

element-order  Порядок элементов, который будет использован в расчете. Независимо 
от имени группы элементов в базе данных, вы можете указать исполь-
зование элементов первого (линейных) или второго (параболических) 
порядка. Например, если при моделировании вы использовали элемен-
ты TETRA4, а в расчете используете элементы второго порядка, то при 
расчете будут учитываться средние узлы на ребрах элементов. С дру-
гой стороны, вы можете использовать элементы TETRA10 при модели-
ровании и элементы первого порядка в расчете. Элементы SOLID 
обрабатываются аналогично, за исключением того, что для элементов и 
первого и второго порядков используется одно имя группы элементов.  
EQ. 1 использовать элементы первого порядка  
EQ. 2 использовать элементы второго порядка  
 (по умолчанию 2) 

tolerance  Допуск сходимости для нелинейных задач 
(по умолчанию 0.001) 

unused-option  Неиспользуемое приглашения, оставленное для совместимости с пре-
дыдущими версиями 

mass-form)  Формулировка матрицы массы, используемой в расчете переходного 
состояния. Также влияет на формулировку матрицы для конвекции  
радиации.  
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EQ. 1 Сосредоточенная (игнорируется, если используются элементы 
второго порядка)  
EQ. 2 Совместимая  
(по умолчанию 1) 

ПРИМЕЧАНИЕ: Значения первого приглашения SN и TN не рассматриваются. Про-
грамма будет автоматически учитывать нелинейную природу задачи, если таковая 
присутствует. 

Выполнение термального расчета 

Команда R_THERMAL (Analysis > HEAT TRANSFER > Run Thermal Analysis) выполняет 
термальный расчет в модуле HSTAR или в термальном модуле FFE. Модуль, запус-
каемый командой, определяется порядком выполнения команд A_FFETHERMAL и 
A_THERMAL. Команда запустит модуль HSTAR, если не была выполнена ни одна из 
них. 

Постпроцессинг 

Результаты, полученные в термальном расчете, можно отобразить графически в GEO-
STAR. Чтобы получить контурные графики температур, градиентов температур или 
теплового потока, используйте Results > PLOT > Thermal. В появившемся окне необ-
ходимо задать настройки графика. Заметьте, что если вы предпочитаете вводить ко-
манды с клавиатуры, то необходимо использовать две команды: ACTTEMP и 
TEMPLOT. Также вы можете отобразить временные характеристики температур, гра-
диентов температур и т.д. в любом узле. Сначала выполните команду ACTXYPLOT 
(Display > XY PLOTS > Activate Post-Proc), чтобы загрузить необходимые данные в 
память и выполните команду XYPLOT (Display > XY PLOTS > Plot Curves). 

Проверка исходных данных модели 

Одной из сложностей, с которыми вы можете столкнуться при расчете, является избе-
жание ошибок в исходных данных модели. Некоторые из ошибок можно обнару-
жить, отобразив модель в различных проекциях, выведя на экран информацию об 
элементах, узлах, группах элементов, свойствах материла и вещественных констан-
тах, нагрузках и ограничениях. В небольших задачах часто бывает легче выполнить 
эти проверки, чтобы убедиться, что все исходные данные введены правильно. Одна-
ко вы можете упустить некоторые труднообнаружимые ошибки. В таких ситуациях, а 
также для больших задач, лучше будет выполнять проверки модели автоматически. 
Термальный модуль COSMOS/FFE предоставляет мощные инструменты автоматиче-
ской проверки правильности созданной вами в GEOSTAR КЭ-модели. В таблице 
приведены команды, которые можно использовать для проверки модели. 

Таблица 4-2. Команды проверки исходных данных 

Путь меню Краткое имя команды Функция 
Meshing 
> ELEMENTS 
> Check Element  

ECHECK  Проверяет соотношение сторон указанных элементов. Ко-
манда автоматически удаляет вырожденные элементы. 
Также команда проверяет порядок задания узлов. 

Analysis  
> Data Check  

DATA_CHECK  Проверяет наличие группы элементов, набора свойств ма-
териала и набора вещественных констант для каждого эле-
мента в модели. 

Analysis  R_CHECK  Выполняет тщательную проверку модель на правильность 
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> Run Check   и законченность данных для указанного типа расчета. 

Функции команды DATA_CHECK является подмножеством команды R_CHECK. 

Хотя команда R_CHECK определяет элементы с неправильной геометрией, удаление 
вырожденных элементов выполняется командой ECHECK. 

ПРИМЕЧАНИЕ: Пользователю настоятельно рекомендуется использовать команду 
R_CHECK и вносить необходимые изменения до выполнения расчета. 

Заметьте, что команда R_CHECK является инструментом общей проверки модели. Мо-
гут существовать ошибки, не обнаруживаемые этой командой. В большинстве случа-
ев сообщения, выводимые либо на экран, либо в ASCII-файл имя_задачи.CHK, 
предоставят информацию о природе этих ошибок и способе их устранения.  

Глава 5. 
Примеры 

Введение 

В данной главе приведено подробное описание примеров линейного и нелинейного 
расчетов теплопереноса в термальном модуле COSMOS/FFE. 

Ниже приведены некоторые советы по выполнению расчета теплопереноса в термаль-
ном модуле COSMOS/FFE: 

! Рекомендуется не использовать версию, поддерживающую 256,000 узлов, если 
размер вашей задачи не превышает 64,000. 

! Команда A_FFETHERMAL (Analysis > HEAT TRANSFER > FFE Thermal Options) 
задает настройки для всех последующих расчетов в термальном модуле FFE. 
Команда A_THERMAL (Analysis > HEAT TRANSFER > Thermal Analysis Options) 
задает настройки модуля HSTAR, стандартного модуля термального расчета 
COSMOS/M. 

! Если вы используете файлы исходных данных модуля HSTAR для выполнения 
расчета в термальном модуле COSMOS/FFE, то для задания настроек расчета вы 
должны использовать команду A_FFETHERMAL. 

! Информация об использованных ресурсах и сообщения расчетного модуля запи-
сываются в файл вывода с расширением .OUT. 

! Следует заметить, что база данных, созданная в версии, поддерживающей 
64,000 узлов, не будет совместима с версией GEOSTAR, поддерживающей 
256,000 узлов (и наоборот). Следовательно, если вы планируете выполнить рас-
чет термальных напряжений с использованием термального модуля FFE, убеди-
тесь что вы используете версию GEOSTAR, поддерживающую 64,000. Это 
неизбежно, поскольку модуль STAR поддерживает только 64,000 уз-
лов/элементов. 

! Продолжение расчета переходного состояние выполняется командой RESTART 
(Analysis > Restart). 
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Пример 1 � Линейный расчет теплопереноса 

В данном примере рассматривается линейный расчет теплопереноса устойчивого со-
стояния в трехмерной призматической модели с использование четырех типов эле-
ментов: объемных (SOLID, TETRA4) и элементов оболочки (SHELL4, SHELL3). 

При использовании объемных элементов предполагается, что модель сплошная, а при 
использовании элементов оболочки предполагается, что модель полая. На рисунке 
показана геометрия модели, а также свойства материала и граничные условия. 

 
Рис. 5-1. Геометрия задачи 

Геометрию модели легко создать, если построить ее поперечное сечение в плоскости 
YZ и «выдавив» его по оси X, чтобы создать трехмерную модель. При использовании 
объемных элементов КЭ-сеть будет сгенерирована для всего тела, а при использова-
нии элементов оболочки КЭ-сеть будет сгенерирована только для ПОВЕРХНОСТЕЙ. 
Для начала используйте команду SF4CORD (Geometry > SURFACES > Draw w/ 4 
Coord), чтобы создать ПОВЕРХНОСТЬ со следующими координатами углов: 
Control Panel: Geometry > SURFACES > Draw w/ 4 Coord (SF4CORD) 
Surface Label [1] > 1 
XYZ coordinates of Keypoint 1 [0,0,0] > (0,0,0) 
XYZ coordinates of Keypoint 2 [0,0,0] > (0,50,0) 
XYZ coordinates of Keypoint 3 [0,0,0] > (0,50,50) 
XYZ coordinates of Keypoint 4 [0,0,0] > (0,0,50) 
Примите значения 

Затем используйте команду VLEXTR (Geometry > VOLUMES > GENERATION MENU > 
Extrusion), чтобы «выдавить» поперечное сечение по оси X: 
Control Panel: Geometry > VOLUMES > GENERATION MENU > Extrusion (VLEXTR) 
Beginning Surface > 1 
Ending Surface [1] > 
Increment [1] > 
Axis symbol [Z] > X 
Value > 100 
Примите значения 

Теперь, когда геометрия модели полностью создана, вы можете приступить к генера-
ции КЭ-сети. Рассматриваются четыре различных случая: 
Случай Тип элементов Число узлов Число элементов 

A Шестигранные элементы второго порядка 7936 6750 
B 4-узловые элементы оболочки второго порядка 2252 2250 
C 3-узловые элементы оболочки второго порядка 1002 2000 
D Четырехгранные элементы второго порядка 951 3972 
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Случай A � Шестигранные элементы (SOLID) 

Команда VLEXTR создает ОБЪЕМ, КЭ-сеть для которого может быть сгенерирована с 
использованием элементов первого порядка (8-узловых) с помощью команды M_VL 
(Meshing > PARAMETRIC MESH > Volumes) (Вы можете использовать элементы 
второго порядка при расчете, указав соответствующий признак в команде 
A_FFETHERMAL). Используйте следующие числа элементов вдоль каждой КРИВОЙ: 
Control Panel: Meshing > PARAMETRIC MESH > Volumes (M_VL) 
Beginning Volume [1] > 
Ending Volume [1] > 
Increment [1] > 
Number of nodes per element [8] > 
Number of elements on first curve [2] > 15 
Number of elements on second curve [2] > 15 
Number of elements on third curve [2] > 30 
Примите значения 

На рис. 5-2 показана полученная КЭ-сеть без отображения скрытых линий. 

Далее, необходимо наложить граничные условия по температуре на две из граней мо-
дели командой NTSF (LoadsBC > THERMAL > TEMPERATURE): 
Control Panel: LoadsBC > THERMAL > TEMPERATURE > Define (NTSF) 
Select surfaces 
Выберите Continue 
Beginning Surface > 1 
Value > 10 
Ending Surface [1] > 
Increment [1] > 
Примите значения 

Повторите команду NTSF и приложите граничное условие температуры, равной 0 гра-
дусов на другой поверхности. Приложенные граничные условия показаны на 
рисунке. 

 
Рис. 5-2.  КЭ-сеть и приложенные граничные условия 

Нижеприведенные команды задают группу элементов и свойства материала и закан-
чивают создание модели: 
Control Panel: Propsets > Element Group (EGROUP) 
Element group set label [1] > 1 
Element category > Volume 
Volume type > SOLID 
Выберите Continue 
Примите значения 
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Control Panel: Propsets > Material Property (MPROP) 
Material property set [1] > 1 
Material property name > KX 
Property value > 1.0 
Выберите Continue 
Примите значения 

Перед выполнением расчета теплопереноса необходимо задать настройки расчета, ис-
пользуя команду A_FFETHERMAL (Analysis > HEAT TRANSFER > FFE Thermal Op-
tions): 
Control Panel: Analysis > HEAT TRANSFER > FFE Thermal Options (A_FFETHERMAL) 
Analysis option (T,S) [S] > 
Element order 1=First 2=Second [2] > 
Convergence tolerance [0.001] > 
Max. equilibrium iterations [20] > 20 
Formulation flag [CONS] > CONS 
Примите значения 

Данные настройки задают расчет теплопереноса устойчивого состояния с использова-
нием элементов второго порядка. Теперь можно выполнить команду R_THERMAL 
(Analysis > HEAT TRANSFER > Run Thermal Analysis), запускающую расчет. После 
успешного завершения расчета можно приступать к постпроцессингу результатов. 

Чтобы отобразить распределение температуры (рис. 5-3), выполните следующую ко-
манду: 
Control Panel: Results > PLOT > Thermal 
Time step number [1] > 1 
Component [TEMP] > TEMP 
Выберите контурный график 
Примите значения 

Если вы предпочитаете вводить команды с клавиатуры, необходимо использовать две 
команды: 
GEO > ACTTEMP; 
GEO > TEMPLOT; 

 
Рис. 5-3. Temperature Contour Plot 
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Время расчета данной задачи можно найти в файле вывода (имя_задачи.OUT). 

Случай B � Квадратные элементы оболочки (SHELL4) 

Удалите КЭ-сеть командой MVLDEL (Edit > DELETE > Element on Volume) и выполните 
команду M_SF (Meshing > PARAMETRIC MESH > Surfaces), чтобы сгенерировать 
КЭ-сеть только для ПОВЕРХНОСТЕЙ ОБЪЕМА. Сначала выберите ПОВЕРХНО-
СТИ 1 и 2, затем выберите ПОВЕРХНОСТИ с 3 по 6. Для концевых ПОВЕРХНО-
СТЕЙ используйте по 15 элементов на каждой КРИВОЙ. Для боковых 
ПОВЕРХНОСТЕЙ используйте 15 элементов на короткой КРИВОЙ и 30 элементов 
на длинной. При генерации КЭ-сети для этих ПОВЕРХНОСТЕЙ используйте эле-
менты первого порядка (4-узловые). Поскольку для ПОВЕРХНОСТЕЙ КЭ-сеть гене-
рируется независимо, необходимо использовать команды NMERGE (Meshing > 
NODES > Merge) и NCOMPRESS (Edit > Compress Nodes), чтобы выполнить «слияние» 
узлов и удалить разрывы в нумерации узлов и удовлетворить требование совмести-
мости. 

Для данной задачи необходимо переопределить группу элементов и использовать эле-
менты SHELL4 с опциями по умолчанию. Также для этого элемента необходимо за-
дать толщину 0.1, использовав команду RCONST (Propsets > Element Group): 
(Control Panel: Propsets > Element Group) 
EGROUP,1,SHELL4; 
(Control Panel: Propsets > Real Constants) 
RCONST,1,1,1,6,0.1; 

Для приложения граничных условий на концевые поверхности используйте команду 
NTSF. Для данного случая подходят настройки, ранее заданные в команде 
A_FFETHERMAL. Запустите расчет, выполнив команду R_THERMAL. Как и ранее, ото-
бразите контурный график температуру. Вы увидите, что график совпадает с полу-
ченным при использовании шестигранных элементов. 

Случай C � Треугольные элементы оболочки (SHELL3) 

Удалите КЭ-сеть, выполнив команду MSFDEL (Edit > DELETE > Element on Surface). В 
данном случае будет использована автоматическая генерация трехмерной КЭ-сети 
для МНОГОГРАННИКОВ. На ветке меню From the Geometry > POLYHEDRA выбе-
рите команду Define (PH) и создайте МНОГОГРАННИК на основе существующих 
ПОВЕРХНОСТЕЙ: 
Control Panel: Geometry > POLYHEDRA > Define (PH) 
Label of polyhedron [1] > 1 
Reference entity name [RG] > SF 
Примите значения 
Surface label [1] > 1 
Average element size > 5 
Примите значения 

Затем на ветке меню Meshing > AUTO MESH выберите команду Polyhedra (MA_PH), 
чтобы сгенерировать КЭ-сеть, состоящую из треугольных элементов. По умолчанию 
данная команда создает элементы первого порядка. 

Также необходимо переопределить группу элементов на элементы SHELL3 с опциями 
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по умолчанию. Как и ранее, с помощью команды RCONST задайте толщину 0.1. 
EGROUP,1,SHELL3; 
RCONST,1,1,1,6,0.1; 

Для приложения граничных условий на концевые поверхности используйте команду 
NTSF. Для данного случая подходят настройки, ранее заданные в команде 
A_FFETHERMAL. Запустите расчет, выполнив команду R_THERMAL. Как и ранее, ото-
бразите контурный график температуру.  

Случай D � Четырехгранные элементы (TETRA4) 

Удалите КЭ-сеть командой MSFDEL (Edit > DELETE > Element on Surface). В данном 
случае будет использована автоматическая генерация КЭ-сети для ЧАСТЕЙ. На вет-
ке меню Edit > DELETE выберите команду Polyhedra (PHDEL) и удалите ранее соз-
данный МНОГОГРАННИК. Повторно выполните команду PH и задайте средний 
размер элемента, равный 7.5. Или вы можете использовать команду PHDENSITY 
(Meshing > MESH DENSITY > Polyhedron Elem Size), чтобы задать новое значение 
плотности КЭ-сети для многогранника. Для задания ЧАСТИ необходимо выполнить 
команду PART (Geometry > Define Part). Затем выполните команду Parts (MA_PART), 
находящуюся на ветке меню Meshing > AUTO MESH, чтобы сгенерировать КЭ-сеть 
из четырехгранных элементов. 

Также необходимо переопределить группу элементов на TETRA4 с опциями по умол-
чанию. 
EGROUP,1,TETRA4; 

Для приложения граничных условий на концевые поверхности используйте команду 
NTSF. Для данного случая подходят настройки, ранее заданные в команде 
A_FFETHERMAL. Запустите расчет, выполнив команду R_THERMAL. Как и ранее, ото-
бразите контурный график температуру.  

Пример 2 � Нелинейный расчет теплопереноса (излучение) 

В данном примере рассматривается нелинейный расчет теплопереноса устойчивого 
состояния в объемном теле призматической формы с предписанными температурами 
в одном конце и излучением тепла в среду с температурой 10°C в другом. Одномер-
ная версия данного примера представлена как проверочная задача TN03 и приведена 
в следующей главе. На рисунке показаны геометрия и граничные условия задачи. 

 
Рис. 5-4. Геометрия задачи 
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КЭ-сеть для данной задачи можно легко создать, построив ПОВЕРХНОСТЬ в плоско-
сти XY и сгенерировав для нее КЭ-сеть с использованием четырехугольных элемен-
тов, а затем «выдавив» ПОВЕРХНОСТЬ и КЭ-сеть по оси Z, чтобы создать 
шестигранные объемные элементы. 

Чтобы создать ПОВЕРХНОСТЬ с координатами углов (0,0), (10,0), (10,1) и (0,1), ис-
пользуйте команду SF4CORD (Geometry > SURFACES > Draw w/ 4 Coord): 
Control Panel: Geometry > SURFACES > Draw w/ 4 Coord (SF4CORD) 
Surface label [1] > 1 
XYZ coordinates of Keypoint 1 [0,0,0] > (0,0,0) 
XYZ coordinates of Keypoint 2 [0,0,0] > (10,0,0) 
XYZ coordinates of Keypoint 3 [0,0,0] > (10,1,0) 
XYZ coordinates of Keypoint 4 [0,0,0] > (0,1,0) 
Примите значения 

Сгенерируйте КЭ-сеть, используя четырехугольные элементы, командой M_SF (Mesh-
ing > Surfaces): 
Control Panel: Meshing > Surfaces (M_SF) 
Beginning surface [1] > 1 
Ending surface [1] > 1 
Increment [1] > 1 
Number of nodes per element [4] > 4 
Выберите Continue 
Number of elements on 1st curve [2] > 10 
Выберите Continue 
Number of elements on 2nd curve [2] > 2 
Выберите Continue 
Примите значения 

На рисунке показана ПОВЕРХНОСТЬ и КЭ-сеть, которые будут «выдавлены». 

 
Рис. 5-5. ПОВЕРХНОСТЬ и КЭ-сеть 

В GEOSTAR «выдавливание» производится на основе геометрических примитивов. 
Следовательно, перед «выдавливанием» созданной КЭ-сети по оси Z необходимо ак-
тивизировать признак переноса КЭ-сети с геометрией, использовав команду 
ACTDMESH (Control > ACTIVATE > Default Meshing): 
Control Panel: Control > ACTIVATE > Default Meshing (ACTDMESH) 
Entity > VL 
Default mesh Flag [ON] > ON 
Примите значения 

Затем выполните команду VLEXTR (Geometry > VOLUMES > GENERATION MENU > 
Extrusion) чтобы «выдавить» ПОВЕРХНОСТЬ и КЭ-сеть. По оси Z будут использо-
ваны два слоя элементов. 
Control Panel: Geometry > VOLUMES > GENERATION MENU > Extrusion (VLEXTR) 
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Beginning Surface [1] > 1 
Ending Surface [1] > 
Increment [1] > 
Axis symbol [Z] > 
Value > 1 
Number of layers of elements [4] > 2 
Original mesh update flag [1] > 
Примите значения 

На рисунке показана КЭ-сеть, полученная «выдавливанием», с и без отображения 
скрытых линий. 

 
Рис. 5-6. Полученная КЭ-сеть 

В левом конце необходимо приложить предписанную температуру 1000°C, использо-
вав команду NTSF (LoadsBC > THERMAL > TEMPERATURE > Define): 
Control Panel: LoadsBC > THERMAL > TEMPERATURE > Define (NTSF) 
Выберите ПОВЕРХНОСТИ 
Нажмите OK  
Beginning Surface [1] > 4 
Value > 1000 
Pick/Input Ending Surface [1] > 4 
Increment [1] > 
Примите значения 

В правом конце необходимо приложить граничные условия по излучению, использо-
вав команду RESF (LoadsBC > THERMAL > RADIATION > Define): 
Control Panel: LoadsBC > THERMAL > RADIATION > Define (RESF) 
Выберите ПОВЕРХНОСТИ 
Нажмите OK  
Beginning Surface [1] > 6 
Emissivity Coefficient [1] > 1 
View factor [1] > 
Source temperature > 10 
Ending Surface > 6 
Increment [1] > 
Time curve for source temperature [0] > 
Примите значения 

Постоянная Стефана-Больцмана, необходимая для расчета излучения, задается с по-
мощью команды SB_CONST (Analysis > HEAT TRANSFER > Boltzman Constant): 
Control Panel: Analysis > HEAT TRANSFER > Boltzman Constant (SB_CONST) 
Stefan-Boltzmann constant > 5.67E-8 
Примите значение 

Для задания разности между абсолютным нулем и нулем используемой температур-
ной шкалы используется команда TOFFSET (Analysis > HEAT TRANSFER > Offset 
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Temperature); в данном примере разность равна 273.15. 

На рисунке показаны приложенные к модели граничные условия. 

 
Рис. 5-7.Приложенные граничные условия 

Нижеприведенные команды, находящиеся в меню Propsets, задают группу элементов и 
свойства материалов для данной задачи и завершают создание КЭ-модели: 
EGROUP,1,SOLID; 
MPROP,1,KX,45; 

Перед выполнением расчета теплопереноса необходимо задать настройки расчета, вы-
полнив команду A_FFETHERMAL (Analysis > HEAT TRANSFER > FFE Thermal Op-
tions) и, в данной задаче, использовав значения по умолчанию. 

Теперь можно выполнить расчет командой R_THERMAL (Analysis > HEAT TRANSFER 
> Run Thermal Analysis). После успешного выполнения расчета можно приступать к 
постпроцессингу результатов. На рисунке показан контурный график температуры, 
полученный после выполнения команды Results > PLOT > Thermal. 

Аналитическое решение данной задачи приведено в следующей главе (задача TN03). 
Вычисленная температура излучающей поверхности равна 235.77, в точности совпа-
дающая с аналитическим решением � 235.77. 

 
Рис. 5-8. Temperature Contours 
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Пример 3 � Линейный расчет теплопереноса 

Данная задача является примером большой термальной задачи. Исходные данные для 
данной задачи находятся в файле SSW55.GEO. Модель представляет рулевое устрой-
ство автомобиля. Модель состоит из 5445 узлов и 20407 четырехгранных элементов. 
Материал устройства имеет единичную теплопроводность. Термальные граничные 
условия задачи состоят из предписанных узловых температур величиной 300 граду-
сов в узлах 1224, 1225, 1269, 1474 и 1475. КЭ-модель устройства показана на рисун-
ке. 

 
Рис. 5-9. КЭ-модель рулевого устройства. 

После считывания файла исходных данных вы можете отобразить модель, выполнив 
команду EPLOT (Edit > PLOT > Elements). Для проверки заданных узловых темпера-
тур, свойств материала и данных группы элементов используйте команду NTLIST 
(LoadsBC > THERMAL > TEMPERATURE > List), MPLIST (Edit > LIST > Material 
Props) и EGLIST (Edit > PLOT > Element Groups). Поскольку КЭ-модель уже полно-
стью задана, вы можете выполнить расчет. Чтобы задать настройки расчета, выпол-
ните команду A_FFETHERMAL (Analysis > HEAT TRANSFER > FFE Thermal Options), 
приняв значения по умолчанию. 

Выполните расчет командой R_THERMAL. После успешного выполнения расчета вы 
можете приступить к постпроцессингу результатов. Чтобы графически отобразить 
распределение температуры (рис. 5-10), выполните следующую команду: 
Control Panel: Results > PLOT > Thermal 
Time step number [1] > 1 
Component [TEMP] > TEMP 
Выберите контурный график 
Примите значения 

Если вы предпочитаете вводить команды с клавиатуры, то вы должны выполнить две 
команды: 
GEO > ACTTEMP; 
GEO > TEMPLOT; 
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Рис. 5-10. Контурный график температуры 

Пример 4 � Линейный расчет теплопереноса 

Данная задача является примером большой термальной задачи. Исходные данные для 
данной задачи находятся в файле PTC1.GEO. Модель представляет компонент маши-
ны. Модель состоит из 3,590 узлов и 10,994 четырехгранных элементов. Материал 
модели имеет единичную теплопроводность. Термальные граничные условия задачи 
состоят из узловой температуры в 20 градусов, приложенной к верхней грани, и гра-
ничных условий конвекции с единичным пленочным коэффициентом, приложенных 
к нижней грани. Температура среды для конвекции � 50 градусов. На рисунке пока-
зана КЭ-модель с приложенными термальными граничными условиями. 

 
Рис. 5-11. КЭ-модель для расчета 
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После считывания файла исходных данных вы можете отобразить модель, выполнив 
команду EPLOT (Edit > PLOT > Elements). Для проверки заданных узловых темпера-
тур, свойств материала и данных группы элементов используйте команду NTLIST 
(LoadsBC > THERMAL > TEMPERATURE > List), MPLIST (Edit > LIST > Material 
Props) и EGLIST (Edit > PLOT > Element Groups). Поскольку КЭ-модель уже полно-
стью задана, вы можете выполнить расчет. Чтобы задать настройки расчета, выпол-
ните команду A_FFETHERMAL (Analysis > HEAT TRANSFER > FFE Thermal Options), 
приняв значения по умолчанию. 

Выполните расчет командой R_THERMAL. После успешного выполнения расчета вы 
можете приступить к постпроцессингу результатов. Чтобы графически отобразить 
распределение температуры (рис. 5-12), выполните следующую команду: 
Control Panel: Results > PLOT > Thermal 
Time step number [1] > 1 
Component [TEMP] > TEMP 
Выберите контурный график 
Примите значения 

Если вы предпочитаете вводить команды с клавиатуры, то вы должны выполнить две 
команды: 
GEO > ACTTEMP; 
GEO > TEMPLOT; 

 
Рис. 5-12. Контурный график температуры 
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Глава 6. 
Проверочные задачи 

Введение 

Ниже приведены проверочные задачи, иллюстрирующие различные возможности тер-
мального модуля COSMOS/FFE. 

TL01: Расчет теплопереноса устойчивого состояния в квадратной плите 

Тип: 

Расчет теплопереноса устойчивого состояния с предписанными температурами, эле-
менты SHELL3T. 

Литература: 

Carslaw, H. S., and Jaeger, J. C., "Conduction of Heat in Solids," 2nd Edition, Oxford Uni-
versity Press, 1959. 

Задача: 

Найти температуру в центре квадратной плиты в предписанными температурами на 
краях. 

Дано: 

Теплопроводность = 43.0 w/m °C 

Высота и ширина плиты = 4.0 m 

Граничные условия: 

На стороне AB температура = 0° C 

На стороне BC температура = 0° C 

На стороне CD температура = 0° C 

На стороне DA температура = 100° C 

Советы по моделированию: 

Поскольку плита и граничные условия симметричны относительно I-I, расчет выпол-
няется только для половины модели. 

Аналитическое решение: 

Температура в любой точке (x,y) плиты определяется по формуле:  
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Сравнение результатов: 

В центре плиты (узел 41). 
 Температура °C 
Теория  25.0 
COSMOS/FFE  24.99 
Ошибка 0.04 % 

 
Рис. TL01-1. 

TL02: Теплоперенос устойчивого состояния в ортотропной плите 

Тип: 

Расчет теплопереноса устойчивого состояния с граничными условиями по конвекции, 
элементы SHELL4. 

Литература: 

M. N. Ozisik, "Heat Conduction," Wiley, New York, 1980. 

Задача: 

Найти распределение температуры в ортотропной плите с постоянной скоростью теп-
ловыделения. Края в координатах x=0 и y=0 изолированы, края в координатах x=a и 
y=b излучают тепло в атмосферу, имеющую нулевую температуру. 

Дано: 
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Теплопроводность по направлению x = kx = 10.0 W/m °C 

Теплопроводность по направлению y = ky = 20.0 W/m °C 

Коэффициент теплопереноса конвекцией на стороне BC  =  h1 = 10.0 W/m2 °C 

Коэффициент теплопереноса конвекцией на стороне DC  =  h2 = 20.0 W/m2 °C 

Длина плиты = a = 1.0 m 

Ширина плиты = b = 2.0 m 

Толщина плиты = 0.1 m 

Скорость тепловыделения Q = 100.0 W/m3 

Советы по моделированию: 

Плита смоделирована с использованием 200 элементов SHELL4. 

Аналитическое решение: 

 

Сравнение результатов: 
Узел X (m) Теория COSMOS/FFE 
111 
112 
113 
114 
115 
116 
117 
118 
119 
120 
121 

0.0 
0.1 
0.2 
0.3 
0.4 
0.5 
0.6 
0.7 
0.8 
0.9 
1.0 

8.5094 
8.4832 
8.4045 
8.2728 
8.0874 
7.8471 
7.5505 
7.1959 
6.7811 
6.3038 
5.7613 

8.5102 
8.484 
8.4053 
8.2737 
8.0882 
7.8479 
7.5513 
7.1967 
6.7819 
6.3046 
5.7620 
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Рис. TL02-1. 

TL03: Теплоперенос переходного состояния в длинном цилиндре 

Тип: 

Расчет теплопереноса переходного состояния с граничными условиями по конвекции, 
элементы PLANE2D. 

Литература: 

J. P. Holman, "Heat Transfer," McGraw-Hill Book Company, 1976, p. 117. 

Задача: 

Длинный алюминиевый цилиндр диаметром 5.0 cm с первоначальной температурой 
200° C, неожиданно помещается в конвекционную среду с температурой 70° C и h = 
525 W/m2 °C. Вычислить температуру в радиусе 1.25 cm по истечении одной минуты 
после помещения в среду. 

Дано: 

Радиус цилиндра = ro = 0.025m 

Теплопроводность = K = 215.0 W/m °C 

Плотность = ρ = 2700.0 kg/m3 

Удельная теплота = C = 936.8 J/Kg °C 

Начальная температура = T0 = 200.0° C 

Коэффициент теплопереноса конвекцией = h = 525.0 w/m2 °C 
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Температура среды = T∞ = 70.0° C 

Советы по моделированию: 

Поскольку цилиндр и граничные условия обладают осевой симметрией, для модели-
рования задачи используются элементы PLANE2D в осесимметричном режиме. 

Сравнение результатов: 

Сравнение результатов производится в r = 0.0125 m (узел 21) и t = 60 sec. 
 Температура °C 
Теория  118.4 
COSMOS/FFE  119.49 

 
Рис. TL03-1. 

TL04: Расчет термальных напряжений в полом цилиндре 

Тип: 

Расчет термальных напряжений, элементы PLANE2D в осесимметричном режиме. 

Литература: 

Timoshenko and Goodier, "Theory of Elasticity," McGraw-Hill Book Co., New York, 1961. 

Задача: 

Полый цилиндр подвергается действию двух независимых нагрузок. 

1. Внутреннее давление Pa 
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2. Устойчивое осесимметричное распределение температуры, вызванное следующими 
граничными условиями: 

В r = 1.0 температура = 100.0 

В r = 2.0 температура = 0.0 

Дано: 

E = 30 x 106 psi 

a = 1.0 in. 

b = 2.0 in. 

ν = 0.3 

αx = 1.0*10-6 / °F 

Kx = 1 BTU/in. S °F 

Pa = 100.0 psi 

Ta = 100.0° F 

Tb = 0.0° F 

ПРИМЕЧАНИЕ: Для расчета данной задаче требуется наличие модуля STAR. 

Сравнение результатов: 
Температура °F  

узел 23 узел 42 
Теория  59.401 23.447 
COSMOS/FFE  59.401 23.447 

Напряжения в элементе 7 (центр)  
Tr Tθ 

Теория -398.34 -592.47 
COSMOS/M STAR -398.14 -596.38 
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Рис. TL04-1. 

TL05: Термальный расчет нагревательных кабелей 

Тип: 

Расчет теплопереноса устойчивого состояния, внутреннее тепловыделение, элементы 
PLANE2D. 

Литература: 

J. N. Reddy, "An introduction to the finite element method," McGraw-Hill Book Co., 1984, 
p. 260. 

Задача: 

В проводящей среде находятся нагревательные кабели, показанные на рисунке. Теп-
лопроводности среды равны Kx=10 W/cm °K и Ky=15 W/cm °K.  Температура верхней 
поверхности равна -5° C, нижняя поверхность изолирована. Предположив, что каж-
дый кабель является точечным источником с мощностью 250 W, найти распределе-
ние температур в среде. 

Дано: 

Теплопроводность по направлению x = Kx = 10 W/cm °K 

Теплопроводность по направлению y = Ky = 15 W/cm °K 

Температура среды T = 268° K 

Коэффициент конвекции h = 5 W/cm2 °K 

Скорость тепловыделения в кабеле на единицу длины Q = 250 W 
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Советы по моделированию: 

Поскольку кабели распределены в среде равномерно, задачу можно упростить, рас-
считав только участок ABCD, показанный на рисунке. Из-за симметрии стороны AD 
и BC должны быть изолированы.Поскольку среда симметрична относительно плос-
кости xy, используются элементы PLANE2D в режиме плоских деформаций. 

Сравнение результатов: 
 Температура в узле 113, °C 
Теория  ---- 
COSMOS/FFE  299.10 

 
Рис. TL05-1. 

TL08: Теплоперенос переходного состояния в плите постоянной толщины 

Тип: 

Линейный расчет теплопереноса переходного состояния, элементы TRUSS2D. 

Литература: 

Gupta, C. P., and Prakash, R., "Engineering Heat Transfer," Nem Chand and Bros., India, 
1979, pp 155-157. 

Задача: 

Большая плиты толщиной 62.8 cm имеет первоначальную температуру 50° C. Внезап-
но температура боковых поверхностей повышается и удерживается равной 550° C. 

Найти: 
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a. Температуру в плоскости, отстоящей от левой поверхности на 15.7 спустя 5 часов 
после повышения температуры. 

b. Мгновенную скорость теплового потока на левой поверхности по истечении 5 ча-
сов. 

c. Полный тепловой поток через поверхность за 5 часов. 

Дано: 

Толщина плиты = L = 0.628 m 

Площадь поперечного сечения = 1.0 m2 

Теплопроводность = K = 46.4 J/m - hr °K 

Плотность = ρ = 23.2 Kg/m3 

Удельная теплота = c = 1000 J/Kg - °K 

Начальная температура = Ti = 50° C 

Температура левой и правой поверхностей = Ts = 550° C 

Время решения = 5 часов 

 
Рис. TL08-1. 

Советы по моделированию: 

Поскольку другие размеры плиты бесконечно большие, теплоперенос происходит 
только по толщине, то есть вдоль оси x. Следовательно задачу можно смоделировать 
с помощью одномерных элементов с суммарной длиной L = 0.628 m и площадью по-
перечного сечения A = 1.0 m2. Для моделирования этой задачи используется 16 эле-
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ментов TRUSS2D, как показано на рис. TL08-2. 

 
Рис. TL08-2. 

Аналитическое решение: 

Пусть: 

T = Температура в любой точке x 

Ts = Температура поверхностей 

Ti = Начальная температура 

t = Время 

тогда температура определяется по формуле: 

 

Мгновенная скорость теплового потока через единицу площади в любой точке: 

 

Полный тепловой поток за период времени от t = 0 до t*: 
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Сравнение результатов: 

В момент времени t* = 5 часов. 
 Расстояние (m) Узел Теория COSMOS/FFE Ошибка % 
Температура (T)  0.157 5 183.90 183.42 0.05 
Скорость потока (q)  0.0 1 130880 130030 0.65 
Полный поток (Q)  0.0 1 112533

0 
1092200 2.94 

 
Рис. TL08-3. 

TL09: Теплоперенос в ребре теплообменника 

Тип: 

Расчет теплопереноса, элементы стержня и конвекционного соединителя (CLINK). 

Литература: 

Kreith, F., "Principles of Heat Transfer", International Textbook Co., Scranton, Pennsyl-
vania, 2nd Printing, 1959. 

Задача: 

Ребро теплообменника с квадратным поперечным сечением площадью A, длиной l и 
теплопроводностью k закреплено в стене, температура которой равна Tw. Поверхно-
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стный коэффициент который между ребром и окружающим воздухом равен h, тем-
пература воздуха � Ta, свободный конец изолирован. Найти тепло, отданное ребром, 
q и температуру свободного конца Tl. 

 
Рис. TL09-1. 

Дано: 

b = 1 in. = (1/12)ft 

Площадь поперечного сечения = A = 0.0069 ft2 

Длина ребра = l = 0.667 ft 

Теплопроводность = k = 25 BTU/hr-ft- °F 

Коэффициент конвекции = h = 1 BTU/hr-ft2- °F 

Температура стены = Tw = 100° F 

Температура среды = Ta = 0° F 

Вычисленные исходные данные: 

Площадь конвекции на 1 дюйм длины ребра = 0.02778 ft2. 

Советы по моделированию: 

Конвекционным соединителям в конце присвоена половина площади внутренних эле-
ментов. Узлы с 11 по 19 имеют произвольные координаты. 
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Сравнение результатов: 
 T в узле 9, °F 
Теория  68.594 
COSMOS/FFE  68.615 
Ошибка 0.03 % 

TN01: Теплоперенос с теплопроводностью, зависящей от температуры 

Тип: 

Нелинейный расчет теплопереноса, элементы TRUSS2D. 

Литература: 

Ozisik, M., "Heat Conduction," John Wiley and Sons Inc., 1980, pp. 440-443. 

Задача: 

Найти распределение температуры в плите, изолированной с одной стороны и предпи-
санной постоянной температурой с другой. В плите действует постоянное тепловы-
деление; теплопроводность плиты линейно зависит от температуры. 

Дано: 

Толщина плиты = L = 2.0 m 

Скорость тепловыделения = Q = 100000.0 W/m3 

Теплопроводность = K = 50.0(1+2T) W/m °C 

Граничные условия: 

В x = 0 изолированная граница  

В x = L предписанная температура 100° C 

Для моделирования задачи были использованы двадцать элементов TRUSS2D. 

Аналитическое решение: 

Уравнение теплопереноса устойчивого состояния имеет вид: 

 (K(T) T, x), x + Q = 0 

Where: K = K0(1+ βT), K0 и β � постоянные 

Q = Скорость тепловыделения. 

"," = Обозначает частную производную. 

Граничные условия: 
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В x = 0 

T, x = 0 

x = L 

T = TL (Предписанная температура) 

Решение задачи получено преобразованием Кирхгофа: 

T = [1 + 2βU - 1]/b 

где U = (Q/(2K0))(L2 - x2) + TL + βTL
2/2 

Сравнение результатов: 
Температура °C  

В X = 0.0 (узел 1) В X = 1.0 (узел 11) 
Теория  118.24 113.96 
COSMOS/FFE  118.24 113.96 

 
Рис. TN01-1. 

TN03: Излучение в стержне 

Тип: 

Нелинейный расчет теплопереноса устойчивого состояния, элементы TRUSS2D и 
RLINK. 

Граничные условия: 

Предписанные температуры в x = 0 
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Излучение в x = 10 m 

Задача: 

Найти распределение температуры в стержне, в левом конце которого заданы предпи-
санные температуры, а правый конец излучает тепло в атмосферу. 

 
Рис. TN03-1. 

Дано: 

Длина стержня = 10.0 m 

Площадь поперечного сечения = 1.0 m2 

Теплопроводность = K = 45.0 W/m °C 

Температура среды = T∞ = 10.0° C 

Температура в левом конце = T0 = 1000° C 

Излучение: 

Площадь излучающей поверхности = 1.0 m2 

Коэффициент проекции = 1.0 

Излучающая способность = 1.0 

Постоянная Стефана-Больцмана = 5.67E-8 W/m2 °K4 

 
Рис. TN03-2. 

Аналитическое решение: 
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Рис. TN03-3. 

Распределение температуры в стержне: 

Граничные условия: 

Температура в x = 0, T = T0 

Излучение в x = l 

Главное дифференциальное уравнение: 

d2T/dx2 = 0 

dT/dx = C1 

T = C1x + C2 

Применяя граничные условия в x = 0, T = T0, получим C2 = T0 

Применяя граничные условия в x = l, получим  

-KA dT/dx|x = l = σεAf(Tl
4 - T∞4) 

-KAC1 = σεAf(Tl
4 - T∞4) 

Но имеем Tl = C1l + C2 

Tl = C1l + C2 

C1 = (Tl - T0/l) 

-KA = (Tl - T0/l) = σεAf(Tl
4 - T∞4) 

(σεAf)Tl
4 + (KA/l)Tl = (KA/l)T0 + σεAfT∞4 

Подставляем: 

σ = 5.67E-8 W/m2 °K4 

ε = 1.0 

f = 1.0 

A = 1.0 m2 
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K = 45.0 W/m °K 

T0 = 1000° C = 1273.15° K 

T∞ = 10° C = 283.15° K 

σTl
4 + 4.5Tl = 4.5*1273.15 + 5.67E-8(283.154) = 5729.175 + 364.45954 = 6093.6345 

σTl
4 + 4.5Tl - 6093.6345 = 0 

Решаем нелинейное алгебраическое уравнение по методу Ньютона-Рафсона: 

Xi + 1 = Xi - f(xi)/fґ(xi) для f(x) = 0 

Пусть тепловыделение Q = 0 

5.67E-8 Tl
4 + 4.5Tl - 6093.6345 = 0 = f(Tl) 

fґ(Tl) = 22.68E-8 Tl
3 + 4.5 

Tl = 508.92° K = 235.77° C 

Сравнение результатов: 
 x y z Узел Теория COSMOS/FFE 
Температура 10 ---- ---- 11 235.77 235.77 

Приложение A. 
Устранение неполадок 

Введение 

В данном приложении приведены сообщения об ошибках, выводимые термальным 
модулем COSMOS/FFE, упорядоченные по алфавиту. Также приведены объяснения и 
рекомендации по устранению. 

Неполадка: Bonding is not supported 

(Скрепление не поддерживается) 

В модели вы использовали «скрепление» двух или более тел. В текущей версии стати-
ческого модуля FFE «скрепление» не поддерживается. Используйте модуль STAR 
или измените КЭ-сеть так, чтобы она была совместимой. 

Неполадка: Cannot restart because previous results are not compatible 

(Невозможно продолжить расчет из-за несовместимости предыдущих результатов) 

В модель были внесены изменения после получения результатов, находящихся в базе 
данных. Используйте команду RESTART (Analysis > Restart), чтобы деактивировать 
продолжение расчета, и выполните расчет повторно. 
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Неполадка: Cannot restart without previous results 

(Невозможно продолжить расчет без предыдущих результатов) 

Вы активизировали продолжение термального расчета переходного состояния. Ре-
зультаты расчета в базе данных не обнаружены. Используйте команду RESTART 
(Analysis > Restart), чтобы деактивировать продолжение расчета, и выполните расчет 
повторно. 

Неполадка: Cannot restart without results for the starting point 

(Невозможно продолжить расчет без результатов для начальной точки) 

Вы активизировали продолжение термального расчета переходного состояния. Ре-
зультаты расчета для начального шага решения в базе данных не обнаружены. 

Неполадка: Coordinate system <number> is referenced but not defined 

(Координатная система <номер> используется, но не определена) 

Задайте недостающую координатную систему и повторно запустите расчет, или изме-
ните исходные данные так, чтобы эта координатная система не использовалась. 

Неполадка: Degenerate element <number> 

(Вырожденный элемент <номер>) 

В модели обнаружены вырожденные элементы. Вырожденными называются одномер-
ные элементы с нулевой длиной, плоские элементы с нулевой площадью и объемные 
элементы в нулевым объемом. Используйте команду ECHECK (Meshing > ELEMENTS 
> Check Element), чтобы исправить эту неполадку и автоматически удалить одномер-
ные элементы, длина которых меньше PTTOL, плоские элементы, площадь которых 
меньше PTTOL в квадрате и объемные элементы, объем которых меньше PTTOL в 
кубе. Допуск точек задается в команде PTTOL (Geometry > POINTS > Merge Toler-
ance). 

Неполадка: Element <number> has unsupported type 

(Элемент <номер> имеет неподдерживаемый тип) 

Элемент связан с группой элементов, которая не поддерживается текущей версией 
статического модуля FFE. Используйте модуль STAR, или измените группу элемен-
тов. 

Неполадка: Element <number> is pyramid shaped, which is not supported 

(Элемент <номер> имеет неподдерживаемую форму пирамиды) 

Элемент принадлежит к группе элементов SOLID. Узлы, определяющие одну из гра-
ней элемента, переместились в одну точку. Такие элементы не поддерживаются в те-
кущей версии статического модуля FFE. Такой элемент мог быть задан вручную или 
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получен при генерации КЭ-сети для тела с вырожденной гранью. Удалите КЭ-сеть, 
используйте элементы TETRA4 или TETRA10, и используйте автоматическую гене-
рацию КЭ-сети вместо параметрической. Элементы, имеющие форму призмы, под-
держиваются. 

Неполадка: Error while closing a temporary file 

(Ошибка при закрытии временного файла) 

При закрытии временного файла произошла ошибка ввода-вывода. 

Неполадка: Error while positioning a temporary file 

(Ошибка при изменении позиции во временном файле) 

При чтении из временного файла произошла ошибка ввода-вывода. 

Неполадка: Error while reading file <filename> 

(Ошибка чтения файла <имя_файла>) 

При чтении из файла, являющегося частью базы данных COSMOS/M, произошла 
ошибка ввода-вывода. Этот файл может быть поврежден. Проверьте целостность же-
сткого диска, воссоздайте модель, создав новую задачу и использовав команду FILE 
(File > Load...), и попытайтесь еще раз. 

Неполадка: Error while reading from a temporary file 

(Ошибка при чтении из временного файла) 

При чтении из временного файла произошла ошибка ввода-вывода. 

Неполадка: Error while writing to a temporary file 

(Ошибка записи во временный файл) 

При записи во временный файл произошла ошибка. Проверьте доступность дискового 
пространства, целостность системы, в особенности жесткого диска. Воссоздайте базу 
данных и попытайтесь еще раз. 

Неполадка: Error while writing to file <filename> 

(Ошибка при записи в файл <имя_файла>) 

При записи в файл произошла ошибка. Проверьте целостность системы, в особенности 
жесткого диска. Воссоздайте базу данных и попытайтесь еще раз. 

Неполадка: Excessive warping in element <number> 

(Слишком большой перекос в элементе <номер>) 
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Перекос в указанном квадратном элементе оболочки слишком большой и приведет к 
ошибочным результатам. Удалите существующую КЭ-сеть и сгенерируйте новую из 
меньших четырехугольных или треугольных элементов. Если вы будете использо-
вать треугольные элементы, то переопределите группу элементов на SHELL3. 

Неполадка: File <filename> does not contain necessary data 

(В файле <имя_файла> не содержатся необходимые данные) 

Указанный файл не содержит необходимых данных в необходимом формате. Возмож-
но файл был поврежден, перезаписан или создан другой версией COSMOS/M. 

Неполадка: File <filename> has invalid format 

(Неправильный формат файла <имя_файла>) 

Формат указанного файла не соответствует ожидаемому. Возможно файл был повреж-
ден, перезаписан или создан другой версией COSMOS/M. 

Неполадка: Improper axisymmetric model 

(Неправильная осесимметричная модель) 

Осесимметричная модель задана неправильно. Осесимметричные элементы должны 
быть заданы в глобальной плоскости XY, где ось Y представляет ось симметрии. 

Неполадка: Improper mesh near element <number> 

(Неправильная КЭ-сеть возле элемента <номер>) 

Возле указанного элемента КЭ-сеть несовместима. Это может быть вызвано непра-
вильным «слиянием» узлов, неправильной параметрической генерацией КЭ-сети из 
четырехгранных элементов или неправильными элементами, созданными вручную. 

Неполадка: Improper mesh, properties, or boundary conditions 

(Неправильная КЭ-сеть, свойства или граничные условия) 

Либо КЭ-сеть, либо свойства материала, либо граничные условия были заданы непра-
вильно. Используйте команду R_CHECK (Analysis > Run Check). Также выведите и 
изучите свойства материала и граничные условия. 

Неполадка: Incompatible element groups 

(Несовместимые группы элементов) 

Созданная КЭ-сеть содержит элементы, группы которых несовместимы друг с другом. 
Попробуйте использовать другие группы элементов, чтобы степени свободы были 
совместимы. 

Неполадка: Internal error # <number> 
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(Внутренняя ошибка <номер>) 

Произошла внутренняя ошибка. Запишите номер и сообщите в S.R.A.C. 

Неполадка: Invalid combination of first and second order elements 

(Неправильная комбинация элементов первого и второго порядков) 

Элементы первого и второго порядков соединены таким образом, что получились не-
правильные общие ребра. Пример: соединение элементов TETRA4 с элементами 
TETRA10. Используйте команду ECHANGE (Meshing > Element Order), чтобы испра-
вить это, увеличив порядок элементов первого порядка или понизив порядок элемен-
тов второго. Также рекомендуется, но не обязательно, изменить группу элементов. 

Неполадка: Invalid curve 

(Неправильная кривая) 

Обнаружена неправильная температурная или временная кривая. Проверьте исходные 
данные. Для отображения температурных и временных кривых можно использовать 
команды ACTXYPRE (Display > XY PLOTS > Activate Pre-Proc) и XYPLOT (Display > 
XY PLOTS > Plot Curves). Переопределите неправильные кривые, используя команду 
CURDEF (LoadsBC > FUNCTION CURVE > Time/Temp Curve) и выполните расчет по-
вторно. Также возможно повреждение базы данных. 

Неполадка: Invalid order of nodes for element <number>, try ECHECK command to fix 

(Неправильный порядок узлов в элементе <номер>, попробуйте команду ECHECK) 

Узлы, определяющие указанный элемент, заданы неправильно. Отобразите элементы с 
включенной нумерацией узлов, и используйте команду ELIST (Edit > LIST > 
Elements), чтобы изучить порядок задания узлов. Такая ошибка может произойти, ес-
ли элементы были заданы вручную командой EL (Meshing > ELEMENTS > Define 
Element). Используйте команду ECHECK (Meshing > ELEMENTS > Check Element), ес-
ли элемент вырожденный. 

Неполадка: Invalid time interval for the analysis <start>, <end> 

(Неправильный временной интервал для расчета <начало>,<конец>) 

Временной интервал, заданный для термального расчета переходного состояния, не-
правильный. Используйте команду TIMES (LoadsBC > LOAD OPTIONS > Time Pa-
rameter), чтобы исправить ошибку. 

Неполадка: Maximum number of nonlinear iterations <number> exceeded 

(Превышено максимальное число нелинейных итераций <число>) 

Максимально допустимое число нелинейных итераций, при этом сходимость не была 
достигнута. Проверьте исходные данные. Если ошибок не обнаружено, установите 
большее допустимое число. Используйте меньший временной интервал для расчета 
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переходного состояния. 

Неполадка: Not enough boundary conditions 

(Недостаточно граничных условий) 

Не заданы граничные условия, или заданных граничных условий недостаточно. Ис-
пользуйте команды меню LoadsBC > HEAT TRANSFER для проверки исходных дан-
ных. Задайте большее количество граничных условий и повторите расчет. 

Неполадка: Out of memory or swap space 

(Не достаточно памяти или файла подкачки) 

Доступной виртуальной памяти недостаточно для решения задачи. Если вы исполь-
зуете UNIX-систему, свяжитесь с системным администратором. 

Неполадка: Too many time steps 

(Слишком много временных шагов) 

Превышено максимально допустимое число временных шагов расчета переходного 
состояния (в текущей версии � 2400). 

Неполадка: Unable to create a temporary file 

(Невозможно создать временный файл) 

Статический модуль FFE не может создать временный файл. Проверьте целостность 
жесткого диска и наличие дискового пространства. 

Неполадка: Unable to create file <filename> 

(Невозможно создать файл <имя_файла>) 

Статический модуль FFE не может создать указанный файл. Проверьте целостность 
жесткого диска и наличие дискового пространства. 

Неполадка: Unable to open file <filename> 

(Невозможно открыть файл <имя_файла>) 

Статический модуль FFE не может открыть указанный файл, являющийся частью базы 
данных COSMOS/M. Возможно этот файл был удален. Проверьте целостность диска; 
воссоздайте модель. 

Неполадка: Unable to open problem database 

(Невозможно открыть базу данных задачи) 

Статический модуль FFE не может открыть базу данных задачи. Проверьте, что база 
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данных находится там, где указано и что используется правильная версия. Также 
проверьте целостность жесткого диска и наличие дискового пространства. 

Неполадка: Unexpected end of file while reading <filename> 

(Неожиданный конец файла при чтении <имя_файла>) 

При считывании данных из файла был обнаружен символ конца файла до окончания 
считывания всех необходимых данных. Проверьте исходные данные, исправьте 
ошибки, если таковые имеются. Попробуйте воссоздать файл, проверьте целостность 
системы; воссоздайте базу данных. 

Неполадка: You are not authorized to use this type of analysis 

(Вы не можете использовать этот тип расчета) 

Программа PRODUCT_INFO (Control > MISCELLANEOUS > Product Info) выведет спи-
сок модулей, лицензией на использование которых вы обладаете. Свяжитесь с 
S.R.A.C. 

Неполадка: Zero or negative cross section area for element <number> 

(Нулевая или отрицательная площадь поперечного сечения элемента <номер>) 

Площадь поперечного сечения указанного элемента равна нулю или отрицательна. 
Используйте команду ELIST (Edit > LIST > Elements), чтобы найти связанную группу 
элементов и команду RCLIST (Edit > LIST > Real Constants), чтобы вывести вещест-
венные константы. Используйте команду RCONST (Propsets > Real Constant), чтобы 
задать положительное значение. 

Неполадка: Zero or negative heat conductivity for element <number> 

(Нулевое или отрицательное значение теплопроводности для элемента <номер>) 

Значение теплопроводности для указанного элемента равно нулю или отрицательно. 
Используйте команду ELIST (Edit > LIST > Elements), чтобы найти связанный набор 
свойств материала и команду MPLIST (Edit > LIST > Material Props), чтобы вывести 
свойства материала. Используйте команду MPROP (Propsets > Material Property), чтобы 
задать положительное значение. 

Неполадка: Zero or negative real constant for radiation link element <number> 

(Нулевое или отрицательное значение вещественной константы для радиационного 
соединителя <номер>) 

В наборе вещественных констант, связанных с указанным элементов, задано непра-
вильное значение. Используйте команду ELIST (Edit > LIST > Elements), чтобы найти 
связанный набор вещественных констант и команду RCLIST (Edit > LIST > Real Con-
stants), чтобы вывести значения набора и проверьте значения площади излучающей 
поверхности, коэффициента проекции, излучающей способности и постоянной Сте-
фана-Больцмана. Используйте команду RCONST (Propsets > Real Constant), чтобы ис-
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править ошибку. 

Неполадка: Zero or negative thickness for element <number> 

(Нулевая или отрицательная толщина элемента <номер>) 

Толщина указанного элемента равна нулю или отрицательна. Используйте команду 
ELIST (Edit > LIST > Elements), чтобы вывести данные групп элементов и наборов 
вещественных констант, связанных с ними, после чего используйте команду RCONST 
(Propsets > Real Constant), чтобы переопределить толщину. 

Неполадка: Zero or negative time increment 

(Нулевое или отрицательное значение инкремента времени) 

Задано неправильное значение инкремента времени в команде TIMES. Используйте 
команду TIMES (LoadsBC > LOAD OPTIONS > Time Parameter) и задайте положи-
тельное значение. 
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